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A. INTRODUCTION 

This Data Acquisition and Processing Report outlines the acquisition and processing 
procedures used for the Hydrographic surveys of Strait of Juan de Fuca (OPR-N305-FA-14) 
and South Kodiak (OPR-P335-FA-14) by NOAA Ship Fairweather.  
 
Survey specific details will be listed in Descriptive Reports as needed.  Unless otherwise noted, 
the acquisition and processing procedures used and deliverables produced are in accordance 
with the NOAA Hydrographic Survey Specifications and Deliverables Manual (HSSD) April 
2014, the Field Procedures Manual (FPM), April 2014, and all active Hydrographic Surveys 
Technical Directives (HTD). 
 
Any additions and changes to the following will be included with the individual Descriptive 
Reports or by submission of an addendum. 
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B. EQUIPMENT 

Detailed descriptions of the equipment and systems, including hardware and software, used for 
bathymetric data acquisition and processing are listed below. 
 

1.0 Hardware 

 
1.1 Hardware Systems Inventory 

Detailed hardware information, including models and serial numbers, is included in Appendix I 
of this report.  All launch hardware was verified during the months of February and March 
2014.  Manufacturer’s product specifications are maintained with reference documentation on 
board Fairweather. 
 
1.2 Echo Sounding Equipment 

 
1.2.1 Reson 7125 SV Multibeam Echosounder (MBES) 

Survey launches 2805, 2806, 2807, and 2808 are each equipped with a dual frequency Reson 
7125 SV MBES.  The Reson 7125 SV has both a low frequency (200kHz) and high frequency 
(400kHz) transmit array with swath coverage of 128°.  The swath is made up of 256 discrete 
beams for 200 kHz and either 256 or 512 discrete beams for 400 kHz.  The typical operational 
depth ranges for the Reson 7125 SV operating at 200 kHz is 3 to 400 meters and 3 to 100 
meters operating with the 400 kHz system.  Each system is hull mounted along the centerline 
and includes a single topside unit (see Figure 1 & Figure 2).  No calibration information was 
provided by the manufacturer for the systems.  Research is ongoing for 7125 SV backscatter 
calibration at the University of New Hampshire.   
   

    

 

   Figure 1: Reson 7125 SV topside processor      Figure 2: Reson 7125 SV transducer arrays 
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1.3 Positioning, Heading, and Attitude Equipment 

1.3.1 Applanix Positioning and Orientation System for Marine Vehicles (POS MV) 

Fairweather’s launches are each equipped with a POS MV 320 V4, configured with 
TrueHeave™.  The POS MV calculates position, heading, attitude, and vertical displacement 
(heave) of a vessel.  It consists of a rack mounted POS Computer System (PCS), a strap down 
IMU-200 Inertial Measurement Unit (IMU), and two GNSS antennas corresponding to GNSS 
receivers in the PCS.  Launches 2805, 2806, 2807, and 2808 are equipped with Zephyr II 
GNSS antennas with BD960 PCS receiver cards.  All launch PCS units for 2805, 2806, 2807, 
and 2808 have internal logging capabilities to eliminate packet drops across the acquisition 
network.  The port side antenna is designated as the primary receiver, and the starboard side 
antenna is the secondary receiver for all vessels (see Figure 3).  The POS MV firmware 
versions and the controller software versions that are currently installed are listed in the 
Hardware Inventory in Appendix I.  
 
For all multibeam systems aboard Fairweather’s launches, timing between the sonar swath, 
position, heading and attitude information was synchronized by utilizing the proprietary UTC 
string from POS MV.  A timing string is sent from the POS MV to the Reson topside unit via 
serial connection and to the Hypack acquisition computer via Ethernet.   
 
For the launch PCS units with internal logging capabilities, data is logged as small 12 MB files 
which can be concatenated into a single .000 file. When files are concatenated, it occurs 
through the NOAA in-house tool “POSConcatenator” created by Grant Froelich of the Pacific 
Hydrographic Branch.  
 
POS MV controller software is used to monitor position accuracy and quality during data 
acquisition.  This ensures that positioning accuracy requirements are met, as outlined in section 
3 of the HSSD.  The POS MV controller software provides clear visual indications whenever 
accuracy thresholds are exceeded.  
 
1.3.2 POS MV GAMS Calibration 

In the spring of 2014, GNSS Azimuth Measurement System (GAMS) calibrations were 
performed on each of Fairweather’s POS MV units mounted to the launches.  The GAMS 
calibration procedure was conducted in accordance with instructions in chapter 4 of the POS 
MV V4 User Guide, 2009.  Results and calibration reports are maintained with reference 
documentation aboard Fairweather.  Actual calibration dates are listed in the Vessel Inventory 
included in Appendix I and in the calibration documentation in Appendix II. 
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Figure 3: POS GNSS Antennas 

 
1.3.3 DGPS Receivers 

Launches 2805, 2806, 2807, and 2808 are equipped with Hemisphere GPS MBX-4 DGPS 
receivers to correct the POS MV GPS positions used during real-time MBES and SSS data 
acquisition.  The DGPS receivers are configured in manual mode to allow reception of only 
one U.S. Coast Guard (USCG) differential GPS beacon station at a time.   
 
Differential GPS (DGPS) is the primary method of real-time positioning.  The individual 
descriptive reports for each survey list the U.S. Coast Guard beacon sites and frequencies used 
for differential corrections utilized during hydrographic surveying. 
 
All individual vessel POSMV files from all platforms are post processed unless otherwise 
noted in respective survey Descriptive Reports and project Horizontal and Vertical Control 
Reports.   
 
 
1.4 Sound Speed Equipment 

1.4.1 Sound Speed Profiles 

1.4.1.1 SBE 19plus SEACAT Profiler 

Fairweather was equipped with two SBE 19plus and three SBE 19plusV2 SEACAT sound 
speed profilers used to acquire conductivity, temperature, and depth (CTD) data in the water 
column to determine the speed of sound through water at the start of the 2014 field season.  
One of the SBE 19plus profilers had pressure sensors rated to 1000 meters; however, this unit 
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was lost in June of 2014 during the South Kodiak project.  The remaining titanium cased SBE 
19plus profiler has a pressure sensor rated to 3,500 meters.  The three SBE 19plusV2 profilers 
have pressure sensors and units rated to 600 meters. 
 
All SEACAT sound speed profilers were calibrated by the manufacturer during the 2013-2014 
winter repair period.  The current calibration files can be found in Appendix I. 
 
Periodic quality assurance checks are conducted regularly and include comparison casts 
between CTD instruments.  Data quality assurance (DQA) checks are conducted during each 
survey leg include comparison casts between two instruments as per section 1.5.2.2.2 of the 
FPM for each survey.  Records of the DQA tests performed are kept aboard the ship and are 
included with the digital Separates II – Sound Speed Data for each survey.  To ensure that the 
CTDs continue to function properly a stringent maintenance schedule is followed using 
guidelines from the manufacturer's recommendations.     
 
 
1.4.2 Surface Sound Speed   

1.4.2.1 Reson Sound Velocity Probe (SVP 71)   

Survey launches 2805, 2806, 2807, and 2808 are each equipped with a Reson SVP 71.  The 
SVP 71 measures the speed of sound near the transducer to provide real time surface sound 
speed values to the Reson 7125’s processing unit.  The 7125 SV requires surface sound speed 
information for beam forming due to the flat faced transducer.  The units are hull-mounted 
adjacent to the Reson 7125’s transducers as shown in Figure 4.   
 
All of the sensors were initially calibrated by the manufacturer and current calibration files 
were supplied with the units upon receipt in 2010.  The delivery calibration files can be found 
in Appendix I. Daily quality assurance checks are completed with the annually calibrated 
Seabird 19+ CTD’s. 
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Figure 4: SVP 71 sound speed unit (right) and a Reson 7125 

 
 

2.0 Software 

2.1 Software Systems Inventory 

An extensive software inventory with documentation of the software systems used by 
Fairweather is maintained as a survey Software Inventory spreadsheet on board Fairweather.  
This spreadsheet includes specifics such as software applications and versions that are loaded 
on specific survey processing computers.  Snapshot .pdf files are produced approximately bi-
monthly or whenever a major software update occurs.  The snapshot inventories are included 
within Appendix I of the DAPR.   
 
2.2 Data Acquisition Software  

2.2.1 Hypack® Hysweep 

Fairweather uses the Hypack® Hysweep acquisition software package to log all Reson MBES 
data.  Hysweep displays real-time MBES coverage geo-referenced against supporting 
background files such as charts and vector shoreline files for the launch coxswain to follow to 
acquire adequate MBES coverage.  The Hypack Devices (Hysweep Interface and Applanix 
POS MV Network) and Hysweep Hardware (Hypack Navigation, Applanix POS MV Network, 
and Reson) *.ini files are created with the support of HSTP field support liaison and are in 
accordance with HSTP’s configuration management documentation.   
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Three types of files are recorded per logged line of Reson MBES data: .raw, .hsx, and .7k.  The 
.raw file contains the raw navigation files recorded directly from the POS MV (as device 0) 
and from Hysweep (as device 1).  The .hsx files contain data from Hypack Navigation (as 
device 0), POS MV (as device 1), and the Reson MBES (as device 2).  The .7k file contains the 
Version 2 Snippet Datagram currently being produced by the Reson MBES.   
 
The .hsx and .raw files are converted into HDCS data in CARIS HIPS by Fairweather 
personnel.  The .7k files are post-processed by Fairweather personnel as required with a 
sample line per sonar, per day, processed for quality assurance testing.  All three raw files are 
submitted directly to NGDC for archival.   
 

2.2.2 Applanix POSView 

Applanix POSView is the controller software for the POS MV.  POSView is used to configure 
the serial and network input and output ports on the POS MV PCS.  POSView is also used to 
monitor real-time position, attitude data, their associated accuracies and to log POSPac .000 
files.  The POSPac .000 file contains the TrueHeave information that is applied to the MBES 
HDCS data in CARIS HIPS immediately after conversion.  The POSPac .000 file is also post-
processed into a PPK SBET file using Applanix’s POSPac processing software.  
  
 

2.3 Data Processing Software 

2.3.1 CARIS 

CARIS HIPS™ (Hydrographic Information Processing System) is used to process all 
multibeam data including data conversion, filtering, sound speed corrections, tide correction, 
merging and cleaning.  CARIS HIPS also calculates the Total Propagated Uncertainty (TPU) 
used to produce Bathymetry Associated with Statistical Error (BASE) surfaces which assist the 
Hydrographer in data cleaning and analysis, and to produce BASE surfaces.   
 
CARIS SIPS™ (Sonar Information Processing System) is used to process all side scan imagery 
data including data conversion, altitude adjustment, slant-range correction, and beam pattern 
correction.  CARIS SIPS is also used to inspect the imagery for contacts and to produce side-
scan imagery mosaics. 
 
CARIS Notebook™ and CARIS Bathy DataBASE™ BASE Editor (BDB) are used to compile, 
display, and edit source shoreline, shoreline updates and S-57 features that are collected 
directly in the field.  The .hob files created in Notebook and BDB are exported to S-57 file 
format as the current shoreline deliverables.    
 
CARIS Bathy DataBASE™ BASE Editor is also used for data quality assurance checks on the 
BASE surface and for surface differencing.  
 
CARIS Plot Composer is used to create final field plots and special constituent products.   
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2.3.2 Fledermaus™ and FMGT 

Fledermaus ™, an Interactive Visualization Systems 3D™ (IVS 3D) program, is used for data 
visualizations and creation of data quality control products, public relations material and 
reference surface comparisons. Fairweather personnel process one line of multibeam 
backscatter per sonar, per day to check Reson Snippet backscatter data in following with the 
best practices established by NOAA personnel to date.  If warranted, specifics of its use or 
findings for a given survey will be documented in the individual descriptive report.   
  
2.3.3 Applanix POSPac MMS and POSGNSS 

Applanix POSPac MMS and POSGNSS are used to post process POS MV data files logged 
during MBES acquisition.  The Single Base PPK processing method is typically used when a 
single Fairweather or third party GPS base station is operating within approximately 30 
kilometers of MBES acquisition.  The SmartBase™ PPK processing method is used when a 
stable network of approximately 5-10 available third party GPS base stations such as those in 
the Continuously Operating Reference Station (CORS) system or Plate Boundary Observatory 
(PBO) suite of stations exists within approximately 200 kilometers of MBES acquisition.  On 
occasion Precise Point Positioning (PPP) is used when sufficient base stations are not available 
for Single Base or SmartBase™ PPK.  In general, Fairweather processing procedures follow 
the methods outlined in the POSPac MMS GNSS-Inertial Tools User Guide for each method.  
Processing methods specific to each project are documented in the Project Horizontal and 
Vertical Control Report.  Processing methods specific to each survey are documented in the 
Descriptive Report   
 
2.3.4 Velocipy 

Velocipy is a NOAA in-house software supported by the Hydrographic Systems and 
Technology Program (HSTP) that is used to process raw sound velocity cast files taken with 
the SEACAT CTDs on the launches and the MVP from the ship.  Velocipy creates CARIS 
format .SVP files that are applied during post processing in HIPS to MBES HDCS data to 
correct for sound speed.  The individual CTD and MVP files are concatenated into a single 
vessel file by survey.  Each vessel file contains the survey registry number and the time and 
location of each sound speed profile measured.   
 
2.3.5 Pydro 

Pydro, another NOAA program produced and maintained by HSTP, is used to produce Final 
Water Level Requests along with DTON Reports and Survey Feature Reports. The xml 
Descriptive Report (DR) is produced using the xml DR component of Pydro; the DR pdf file is 
then produced via a style sheet.  In addition, Pydro is used for Tidal Constituent and Residual 
Interpolation (TCARI) tide application in conjunction with CARIS HIPS and various other 
macros.   
 
Pydro is utilized to assist with sidescan and multibeam contact correlation.  Information about 
each contact is easily entered, images can be added and a final feature report can be produced. 
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2.3.6   POSPac AutoQC 
 
The POSPac Automated QC is a NOAA in-house software developed by the Hydrographic 
Systems and Technology Program (HSTP) that is accessed from the Pydro64 Contribs 
launcher. SBET files must be QC’d for decimeter and larger faults in the processed solution. 
The POSPacAutoQC tool is based on a mechanization of the SBET Solution Quality 
Assessment as discussed in the POSPac MMS manual. 
 
ERS measurements corrected to the in situ quiescent water level form a “qualitative hydro 
ground truth” that may be used for the QC of SBET altitude. 
 

3.0 Vessels  

3.1 Vessel Inventory 

Fairweather’s survey launches 2805, 2806, 2807, and 2808 are equipped to acquire multibeam 
echosounder (MBES) and sound speed profile (.svp) data.  See Appendix I for the complete 
vessel inventory. 
 

4.0 Data Acquisition 

4.1 Horizontal Control 

A complete description of horizontal control will be included in the project’s Horizontal and 
Vertical Control Report (HVCR), submitted for each project under separate cover when 
necessary as outlined in section 8.1.5.2 of the HSSD and section 5.2.3.2.3 of the FPM. 
 
The horizontal datum for all projects is the North American Datum of 1983 (NAD83) unless 
otherwise noted in the individual descriptive reports.   
 
Multibeam and shoreline data are differentially corrected in real time using correctors provided 
by Coast Guard beacons.  The specific beacons used for a given survey will be included in the 
Horizontal Control section of the survey’s descriptive report.  If loss of the differential beacon 
resulted in any data being recorded with C/A GPS positions it will be noted in the Descriptive 
Report for the specific survey.   
 
When possible, real time DGPS positioning may later be replaced with a post processed 
kinematic (PPK) single best estimate of trajectory (SBET). The PPK solution is usually 
dependent on a local base station supported by the ship and processed in Applanix POSPac 
MMS software using Single Base mode.  However, in areas with an adequate network of 
Continuously Operating Reference Stations (CORS) or public third-party base stations, 
Applanix POSPac SmartBase™ mode may be used.  With either Single Base or SmartBase 
processing, the resulting navigation from PPK is an improvement over C/A and DGPS 
navigation. The details of PPK use and application for a given survey will be included in the 
Horizontal Control section of the project’s HVCR or the survey’s descriptive report.   
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4.2 Multibeam Echosounder Acquisition and Monitoring Procedures 

Acquisition methods and platforms used are determined based on consideration of sonar 
system specifications, seafloor topography, water depth, and the capability of the acquisition 
platforms.   
 
All multibeam data are acquired in Hypack’s Hysweep® SURVEY extension (.hsx) format and 
monitored in real-time using the 2-D and 3-D data display windows and the on-screen displays 
for the Reson 7125 SV.  Adjustable parameters that are used to control the Reson include range 
scale, power, gain, pulse width, absorption, and spreading.  These parameters are adjusted as 
necessary to acquire the highest quality of bathymetry and backscatter.  At this time, Satmon 
for backscatter monitoring is still being configured and calibrated aboard Fairweather.  Best 
practices for backscatter monitoring with Satmon are expected to be in place aboard 
Fairweather for the 2015 Field Season.  Vessel speed for acquisition is predominantly between 
6-8 knots for acquisition with launch 7125 SV systems.  Speeds are reduced as needed to 
eliminate noise from the data and to ensure the required along-track coverage for object 
detection in accordance with the HSSD.   
 
Survey personnel follow standard operating procedures documented aboard Fairweather while 
setting and utilizing the Reson systems and Hypack for data acquisition.  The sensor offsets 
and mounting biases are entered into the Hysweep® Hardware Reson device.  This information 
is recorded in the Hypack hsx file header for corrected backscatter mosaics created with 
Hypack Geocoder.  These offsets do not have any effect on CARIS HIPS HDCS sounding 
corrections.    
 
Navigation and motion data are acquired and monitored in POSView and logged into a POS 
MV file with a .000 extension.  Various position and heading accuracies, as well as satellite 
constellations, are monitored real-time both in POSView and Hypack Hysweep®. 
 
Main scheme MBES acquisition lines using the Reson 7125 SV are generally run parallel to 
the contours with appropriate overlap to ensure data density requirements for finalized BASE 
surface resolutions are met.  For discrete item developments, 200 percent coverage is acquired 
to ensure least-depth determination by multibeam near-nadir beams.  Hypack Hysweep® real-
time coverage display is used in lieu of pre-planned line files.  Hysweep® displays the 
acquired multibeam swath during acquisition and is monitored to ensure overlap and full 
bottom coverage.  If coverage is not adequate, additional lines are run while still in the area.  
 
For areas where shoreline verification is not conducted before multibeam, extra caution is 
taken by “half stepping” shoreward when operating near shore.  Half stepping is done by 
driving along the edge of real time coverage to prevent the survey vessel from ever being in 
un-surveyed waters.  Survey launch crews in the field survey to the Navigable Area Limit Line 
(NALL) line as defined by section 1.1.2 of the HSSD. 
 
4.3 Shoreline/Feature Verification 

The composite source file (CSF) in S-57/.000 format provided with the Project Instructions is 
the primary source for shoreline features to be verified.  The original project file is imported 
into CARIS BASE Editor, converted to a .hob file, clipped to the sheet limits for the specific 
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survey, and named H#####_Original_Composite_Source.hob to be included with the 
deliverables.  This file is then copied and named H#####_Feature_File.hob to be utilized 
during field verification.  Additionally, AWOIS items and other features to be investigated are 
provided to the field in the project reference file (PRF).  All hob files are re-exported to S-
57/.000 format for data submission. 
 
Fairweather personnel conduct limited shoreline verification and reconnaissance at times near 
predicted negative tides within the survey limits when possible, as directed by section 3.5.5.3 
of the FPM.  Detached positions (DPs) are acquired and edits to the daily field feature files are 
recorded in CARIS Notebook and on paper DP forms and boat sheets.   
 
An inshore limit buffer line, offset 0.8 mm from the Mean High Water (MHW) line at the scale 
of the largest chart in the area, is provided with the Project Instructions.  This inshore limit 
buffer line is used in the shoreline acquisition software and on the boat sheet as a reference, 
and utilized as described in section 1.1.2 of the HSSD.  The NALL is determined in the field as 
the farthest off-shore of one of the following; the MHW inshore limit buffer specified above, 
the 4-meter depth contour, or the inshore limit of safe navigation as defined by the HSSD.  All 
shoreline features from the CSF seaward of the NALL are verified (including an update to 
depth and/or position as necessary) or disproved during operations.  Features off-shore of the 
NALL and not addressed or features of an ambiguous nature include remarks for further 
clarification.  Specifically assigned features may be investigated that are inshore of the NALL 
in accordance with the associated instruction for a given project area.  
 
Detached positions (DPs) acquired during shoreline verification indicate new features, 
revisions to source features, or source features not found in the field.  They are recorded in the 
shoreline acquisition software and on DP forms.  
 
4.4 Bottom Samples 

Bottom samples are acquired according to section 7.1 of the HSSD, any deviations from this 
protocol will be outlined in the individual Descriptive Report for the survey.  Samples are 
acquired using CARIS Notebook, Hypack target files (.tgt), or by logging the latitude, 
longitude, and bottom characteristics manually.  All samples are processed similarly to other 
shoreline features as outlined below in section C - 2.2 of this report.  Bottom sample results are 
included in the Notebook/BDB .hob deliverable layer, HXXXXX_Final_Feature_File and are 
descriptively attributed as New. 
 
4.5 Sound Speed 

Sound speed casts are taken at least once every 1–4 hours during multibeam survey operations 
in accordance with section 3.5.1 of the FPM.  Fairweather’s launches collect sound speed casts 
approximately every 2 hrs utilizing the SBE 19plus and 19plus V2 SEACAT sound speed 
profilers.  These casts are then compared once daily to the SVP 71 surface sound speed (SSP) 
sensors to verify their accuracy in lieu of annual SVP 71 calibration.  The results of the daily 
SSP sensor comparisons are logged in the excel acquisition log to track instrument health.  
Deviations from this procedure will be outlined in the individual Descriptive Report for the 
survey.  
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C. QUALITY CONTROL 

Fairweather has numerous standard operating procedures (SOPs) that are followed by 
personnel throughout the survey to ensure consistent high quality data and products. 
 

1.0 Uncertainty Modeling 

Uncertainty values for the multibeam and positioning systems on Fairweather and her survey 
launches were compiled from manufacturer specification sheets for each sensor (Heave, Pitch, 
Roll, Position, and Heading) and from values set forth in section 4.2.3.8 and Appendix 4 – 
CARIS HVF Uncertainty Values of the 2014 FPM. 
 
The manufacturer specification for POSMV heading accuracy is contingent on a 2 meter 
baseline between primary and secondary GPS antennas.  While the Fairweather has a 2 meter 
baseline her launches have on average a 1.4 meter baseline which has been seen to increase 
accuracy estimates in the field.  Based on observations in the field, the heading error value for 
all launches has been increased from the manufacturer specification and FPM guidance to 0.04 
degrees. 
 
Estimates for the Motion Reference Unit (MRU) alignment errors are taken from the standard 
deviation of the values determined by multiple personnel processing the patch test data (see 
section D 4.0).  In some instances, outlier patch test values are excluded to allow more 
reasonable MRU uncertainty values.                                                                          
 
The Fairweather TPU Values spreadsheet located in Appendix III, lists the final uncertainty 
values for Fairweather and her launches, including the default tides and sound velocity values.  
Uncertainty values relating to vessels and survey systems are entered into the HIPS Vessel File 
(HVF) for each platform.  The tidal errors for the gauge and for zoning are determined on a 
project by project basis. Sound speed uncertainties for a given survey are based upon either the 
defaults listed in the TPU value spreadsheet or based on utilization of NOAA sound speed 
uncertainty estimation software.  Survey specific uncertainty values for tides and sound speed 
that are entered during the Compute TPU step in CARIS HIPS and how they were determined 
will be included in the individual Descriptive Report.  After SBET application, TPU values are 
recalculated using the Error Data option for Uncertainty Source in the CARIS Compute TPU 
window.  This loads more precise residual mean square (RMS) values to selected HDCS lines 
for position, roll, pitch and gyro. 
 

2.0 Data Processing 

2.1 Multibeam Echosounder Data Processing 

Bathymetry is processed following section 4.2 of the FPM unless otherwise noted.   
 
Raw multibeam data is recorded as .HSX files in Hypack, and then converted to CARIS HIPS 
HDCS format using established and internally documented settings.  After TrueHeave™, 
sound speed, and water level correctors are applied to all lines, the lines are merged.  Once 
lines are merged, Total Propagated Uncertainty (TPU) is computed.   
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Bathymetric surfaces are created and analyzed using the resolution, depth range, and CUBE 
parameters outlined in 5.2.2.2 of the HSSD.  If these depth range values for specific resolutions 
require adjustment for analysis and submission of individual surveys then a waiver from HSD 
Operations is required and would be requested.  A detailed listing of the resolutions and the 
actual depth ranges used during the processing of each survey, along with the corresponding 
field sheet(s), will be provided in the Descriptive Report of each survey.   
 
BASE surfaces are created using the Density & Locale function of the CUBE algorithm and 
parameters contained in the NOAA CUBEParams_NOAA.xml.  The 
CUBEParams_NOAA.xml will be included with the HIPS Vessel Files with the individual 
survey data.  The NOAA parameter configurations for resolutions 1-32 meters are used.   
 
Multibeam data are reviewed and edited in HIPS subset mode and in swath editor as necessary.  
The finalized BASE surfaces and CUBE hypotheses are used for directed data editing at the 
appropriate depth range in subset editor.  The surfaces and subset editor view are also used to 
demonstrate coverage and to check for errors due to tides, sound speed, attitude and timing. 
 
Vessel heading, attitude, and navigation data are reviewed in HIPS navigation editor and 
attitude editor if deemed necessary upon review of surfaces.  Where necessary, fliers or gaps in 
heading, attitude, or navigation data are manually rejected or interpolated for small periods of 
time.  Any editing of this nature will be outlined in the Descriptive Report for the particular 
survey. 
 
The Surface Filtering functionality in HIPS may be used in the processing of survey data to 
reject errant soundings.  If utilized, the individual Descriptive Report shall list the confidence 
level settings for standard deviation used and discuss the particular way the surface filter was 
applied.  
 
All crosslines are filtered to 45 degrees off of nadir to ease the cleaning burden when creating 
the stand alone crossline surface for differencing with the main scheme coverage.  
 
In depths less than 20 meters and in areas of navigational significance where the BASE surface 
does not depict the desired depth for the given area, a designated sounding is selected.  
Designated soundings are selected as outlined in section 5.2.1.2 of the HSSD. 
 
Layers determining “IHOness” are added to the CUBE surfaces allowing the Hydrographer to 
see where and if the surfaces meet IHO Order.  The process is easily performed in HIPS and 
allows the Hydrographer to identify areas of high uncertainty with respect to depth.  This is a 
spatial quality control check rather than just a statistical list of nodes and allows for specific 
areas with problems to be isolated and addressed.  The following logic equation is used to 
create “IHO_1” child layers in the 1 through 8 meter finalized surfaces:  
 
IHO-1:  -Uncertainty/((0.5^2 +((Depth*0.013)^2))^0.5), 
 
and an “IHO_2” child layer is created in the 8, 16 meter, and greater finalized surfaces using 
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IHO-2:  -Uncertainty/((1.0^2 +((Depth*0.023)^2))^0.5). 
 
It should be noted that both IHO order 1 (~80 to 100) and order 2 (100 to 176) child layers are 
created for the 8 meter surface since it overlaps the order 1 and order 2 boundary (order1<100 
meters, order 2>100 meters). IHO surfaces are used during processing to indicate potential 
problem areas requiring attention or documentation.  Observed grid node uncertainty values are 
compared to IHO order 1 and Order 2 uncertainty standards.  The percentage of nodes meeting 
or exceeding these standards is calculated for each HIPS CUBE surface with a NOAA-
supported and distributed script, and then reported in the Descriptive Report. For surveyed 
areas that do not meet IHO standards, images of affected areas may be included. 
 
The individual finalized or combined surface’s IHO layers are exported from CARIS as a text 
file and examined to allow the Hydrographer to see the full data distribution rather than just the 
minimum and maximum values in the surface.  These data distribution are used to assess the 
quality of the survey, to ensure ninety-five percent of the data meets the appropriate IHO order 
as specified in section 5.1.3 of the HSSD.   
 
Additionally, a combined surface is reviewed in 3-D mode using one of the following 
programs, CARIS HIPS, CARIS Base Editor, or IVS Fledermaus, to ensure that the data are 
sufficiently cleaned for submission. 
 
 
 
2.2 Shoreline/Feature Data Processing 

During shoreline verification, field detached positions (DP) are acquired with CARIS 
Notebook or Hypack .tgt files.  Tide application for features requiring tide correction is applied 
in CARIS Notebook when using discrete zoning. 
 
New features and any updates to the composite source shoreline, such as ledges or reefs, are 
acquired or digitized with S-57 attribution and compiled from the field daily files into the 
H#####_Final_Feature_File.hob.  Updates to source shoreline features primarily include a 
change in depth/height, position, or S-57 classification.  If the position of a feature changes, 
current guidelines are to delete current feature and create a new feature in the new location.  
Any changes to depth/height or S-57 classification are done so as an update to the S-57 object 
with the inclusion of NOAA’s object attributes.   
 
The SORIND and SORDAT S-57 attribute fields for new features or modified source features 
are updated to reflect the information for the associated survey number and date 
(US,US,graph,H#####).  All new or modified features are S-57 attributed as applicable and 
descriptively attributed as New or Update respectively.  All unmodified source features retain 
their original SORIND and SORDAT values.  Assigned features that are addressed but not 
updated are descriptively attributed as Retain and unaddressed assigned features are attributed 
as Not Addressed. 
 
Short descriptive comments taken from the boat sheets or DP forms along with investigation or 
survey methods are listed under the Remarks field.  For significant features that deserve 
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additional discussion, the Hydrographer may include a recommendation to the cartographer in 
the Recommendations field, along with the Hydrographer notes and investigation methods 
provided in the Remarks field.  
 
Features that are disproved or that do not adequately portray the shoreline are descriptively 
attributed as Delete in the H#####_Final_Feature_File.hob layer.  Features with the attribution 
of Delete retain their original SORIND and SORDAT values and include a recommendation 
from the Hydrographer along with an informative remark.  
 
AWOIS investigation items are received in the Project Reference File and investigated as 
necessary.  Features correlated to the AWOIS item are included in the 
H#####_Final_Feature_File.hob layer and labeled with the appropriate AWOIS number and 
include a remark detailing the search methods and a recommendation from the Hydrographer.  
Items will be attributed as AWOIS for reporting purposes.  Any features that are submitted as 
dangers to navigation (DTON) will be attributed accordingly for reporting purposes.  The 
status of Primary or Secondary may be attributed to aid in de-conflicting multiple positions or 
instances of the same feature.  
 
Images are labeled and associated with a DP/userid number or other descriptive/unique name.  
They are included with the survey data and stored in the CARIS/Multimedia folder with the 
deliverables.  References to the images are listed with file extension and comma delimited in 
the Images attribute for the specific feature. 
 
The CARIS Notebook files along with CARIS HIPS BASE surface(s) are viewed to compare 
MBES coverage and features simultaneously.  The current NOAA object catalog will be used 
for CARIS Notebook processing and the version of such will be documented in the individual 
Descriptive Reports, along with any deviations in shoreline processing from those listed above. 
 
Final shoreline deliverables are two S-57 (*.000) files exported from Notebook, the H##### 
Original Composite Source and the H##### Final Feature File, included with the processed 
data.   
 

3.0 Data Review 

Specific procedures are used on Fairweather to ensure quality control of data throughout 
acquisition, processing, and submission.  These procedures are documented and followed by 
the Hydrographer.  A detailed Quality Control check is performed by the survey manager.  A 
detailed review is conducted by qualified survey personnel (FOO, CST, SST, or PS) other than 
the survey manager as an outside review of the survey data and deliverables.  Submission 
checklists are used to ensure that all data and deliverables are complete and included upon 
submission.  Documentation of these tasks is completed for every survey but only the final 
processing log, H##### Data Log, is included in the Separates submitted with the individual 
survey data. 
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D. Corrections to Echo Soundings 

1.0 Vessel HVFs 

CARIS HIPS Vessel Files (HVF) are created by Fairweather personnel and used to define a 
vessel’s offsets and measurement uncertainty.  The HVF is used for converting and processing 
raw Hypack .hsx and .raw files to CARIS HIPS HDCS format.  The HVFs used for a given 
project are included with the digital data submitted with the survey.   
 

2.0 Vessel Offsets  

Sensor offsets are measured with respect to each vessel’s reference point.  The reference point 
for Fairweather and her survey launches 2805, 2806, 2807, and 2808 is the top, center of the 
POS MV IMU (Figure 5).  The offset values from the reference point to the primary GNSS 
antenna are entered into Applanix’s POSView POS MV monitoring software so that all raw 
position data are centered at the vessel’s reference point.  The CARIS HVF contains the offset 
from the vessel’s reference point to the multibeam sonar reference point. 
 

 
Figure 5: Vessel Reference Point (Top of POS MV IMU) & Primary GNSS Antenna (port side). 

 
 
Additionally, the Reson 7125 sonar mounting offsets measured from the center of each 
projector to the center of the transceiver are entered in the Reson 7125 hardware configuration 
with the 7K Center for both the 400 kHz and 200 kHz projectors.  The measured values are 
used instead of Reson’s default values because Fairweather’s mounts are slightly different 
than of Reson’s standard sonar mount (Figure 6).   
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Figure 6: Reson 7125 sonar mounting with 400k Hz and 200 kHz offsets respectively. 

 
 
Permanent control points were established on launches 2805, 2806, 2807, and 2808 during 
construction at All American Marine in 2009.  Sensor offsets were measured by NGS in 
January 2010 using the methods described in the report on each launch located in Appendix II 
of this report.  The resultant offsets, measurements, derivations, descriptions of methodology 
used, diagrams, and coordinate system references are included in the respective vessel’s 
Offsets & Measurements spreadsheet also included in Appendix II.   
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3.0 Static and Dynamic Draft 

The static drafts (Waterline Height in the HVF) for launches 2805, 2806, 2807, and 2808 were 
calculated based on steel tape and plumb bob measurements of the distance from benchmarks 
on the port and starboard quarter of the vessel to the waterline.  Measurements were conducted 
during March of 2014 in Newport Oregon.  The values and calculations for static draft of the 
various launches are listed in the respective Waterline Measurement spreadsheets included in 
Appendix II of this report.   
 
The dynamic draft data were acquired for launches 2805, 2806, 2807, and 2808 in Newport 
OR.  The measurements were made using the change in ellipsoid height while the vessels were 
transiting at different speeds in their respective locations.  The ellipsoid heights were 
determined using Post Processed Kinematics (PPK) by recording POSPac data on each vessel 
and then processing the data with local reference stations in Applanix POSPac MMS software. 
The resulting Single Best Estimate of Trajectory (SBET) was exported from POSPac and the 
speed versus ellipsoid height was fit to a third order polynomial curve using a least squares fit 
method in a Python Script written by NOAA personnel and implemented within Pydro.  The 
polynomial curve was used to derive the table used in the CARIS HVF, and the standard 
deviation of the residuals was used to determine the associated uncertainty in the measurement.  
Written reports for each platform including initial measurement notes, graphs, and finalized 
values are provided in Appendix II of this report.  The polynomial best fit curve of the 
ellipsoidal height differences from launches 2805, 2806, 2807, and 2808 compare well with 
each other and previous years.  The dynamic draft offset values and standard deviations were 
then entered into the CARIS HVFs. 
 

4.0 Patch Tests 

Patch tests were conducted in accordance with section 5.2.4.1 of the HSSD on all launches for 
the Reson 7125 SV MBES sonar systems during the month of March 2014 using the a buoy 
block in Newport, OR.  The results of all patch tests to date, along with the acquisition and 
processing logs, are included in the individual MBES Calibration files in Appendix II.   
 
Also included in Appendix II is the sounding system comparison between all sonars and 
frequencies.  This comparison includes surface differencing between launch reference surfaces 
using CARIS Bathy Database.  The result of the comparison shows that the differences 
between each platform and sonar are within NOAA specification for vertical uncertainty. 

5.0 Attitude and Kinematic Data 

Vessel attitude is measured by the POS MV and recorded in the Hysweep .hsx file.  Roll is 
corrected in real time for Reson 7125 SV data.  Attitude correctors not applied in real time 
(heave, pitch, roll, and heading) are applied during post processing in CARIS HIPS using the 
raw POS MV attitude data recorded in the Hysweep .hsx file.  Post processed kinematic (PPK) 
data from the POS MV .000 file are applied to MBES data in CARIS HIPS in the form of 
SBET files once all data acquisition is complete.    
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5.1 TrueHeave™ 

The POS MV TrueHeave™  data is logged within the POS MV .000 files and applied in 
CARIS HIPS during post processing using the “Apply TrueHeave” function during sound 
speed correction.  TrueHeave™ is a forward-backward filtered heave corrector as opposed to 
the real time heave corrector, and is fully described in Section 6 of the POS MV V4 User Guide 
2009.  To ensure proper application in CARIS HIPS, POS MV files are logged for at least three 
to five minutes before and after all MBES files are logged.  
 
In cases where TrueHeave™ cannot be applied, real time heave correctors are used.  Real time 
heave data are recorded and stored in the Hypack Hysweep .hsx file and are applied as the 
heave corrector for MBES data if TrueHeave™ files are unavailable.  Data that do not have 
TrueHeave™ applied will be listed in the individual Descriptive Report for the survey.  
 
5.2 Post Processed Kinematic Data 

 
Post Processed Kinematic (PPK) data in the form of Single Best Estimate of Trajectory 
(SBET) files are applied to soundings to increase the accuracy of the kinematic vessel 
corrections and to allow the ability to reference soundings to the ellipsoid.   
 
Standard daily data processing procedures aboard Fairweather include post processing of POS 
MV kinematic .000 files using Applanix POSPac MMS and POSGNSS software using either 
Single Base batch processing or SmartBase processing.  After processing and quality control 
analysis of the post-processed SBET files is complete, the SBET and SMRMSG files are 
applied to the HDCS data in CARIS HIPS using the “Load Attitude/Navigation Data”, the 
“Load error data”, and “Compute GPS Tide” processing tools.  Ellipsoidal heights are 
contained within the PPK SBET files.  Soundings to which SBETs have been applied can be 
reduced to the ellipsoid by merging the data in CARIS HIPS with “GPS Tide” applied.  Data 
are frequently referenced to the ellipsoid during data analysis for troubleshooting unexplained 
vertical offsets, but are reduced back to MLLW for data finalization and submission.  
 
Feature and bottom sample positions are not corrected with post processed GNSS data because 
at this time as there is not a developed or streamlined procedure for PPK application to 
features. 
 
 

6.0 Sound Speed 

Seabird SBE 19plus and SBE 19plusV2 sound speed profilers are used regularly to collect 
sound speed data for the Reson 7125 SV MBES systems on survey launches 2805, 2806, 2807, 
and 2808.  
 
Daily sound speed profiles from the SBE 19plus and SBE 19plusV2 profilers are processed 
with Velocipy and concatenated into single .svp files for each vessel per survey.  Individual 
.svp files and the concatenated vessel files for the survey are submitted with each survey.    
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The concatenated sound speed files are applied to multibeam data in CARIS HIPS during data 
processing.  CARIS HIPS uses one of four different methods to automatically apply a sound 
speed profile stored in a concatenated sound speed file.  They are: “previous in time,” “nearest 
in time,” “nearest in distance” and “nearest in distance within time.”  The method of applying 
sound speed for a specific day of data collection is listed in the daily logs included as Separates 
submitted with the individual survey data. 
 

7.0 Water Level 

Unless otherwise noted in the survey Descriptive Report, the vertical datum for all soundings 
and heights is Mean Lower Low Water (MLLW).  Predicted, preliminary, and/or verified water 
level correctors from the primary tide station(s) listed in the Project Instructions may be 
downloaded from the CO-OPS website and used for water level corrections during the course 
of the project.  These tide station files are collated to include the appropriate days of 
acquisition and then converted to CARIS .tid file format using FetchTides.   
 
Water level data in the .tid files are applied to HDCS data in CARIS HIPS using the zone 
definition file (.zdf) or a Tidal Constituent and Residual Interpolation (TCARI) model supplied 
by CO-OPS.   Upon receiving final approved water level data, all data are reduced to MLLW 
using the final approved water levels as noted in the individual survey’s Descriptive Report. 
 
If available, a VDATUM model comparison might be requested by Office of Coast Survey, 
Operations Branch.  If accepted, CARIS HIPS data may be reduced to MLLW per supplied 
separation model instead of through traditional water level application.  See the individual 
survey’s Descriptive Report for further information. 
 
A complete description of vertical control utilized for a given project can be found in the 
project specific Horizontal and Vertical Control Report (HVCR), submitted for each project 
under separate cover when necessary as outlined in section 5.2.3.2 of the FPM. 
 



Appendix I 
 
 

System Tracking 
 

1. Vessel Inventory 
2. Hardware Inventory 
3. Computer Inventory 

 

Sound Speed Calibration Documentation 
 

1. SPE 19+  
2. SPE 19+ V2 
3. SVP 71 

 



type owner current_location effective_date serial_number cd_number status edited_on

Bottom Sampler Fairweather Fairweather 3/19/2013 BS 1 N/A Active 3/19/2013 23:28

TABLE bottom_sampling

Bottom Sampler Fairweather Fairweather 3/19/2013 BS 2 N/A Active 3/19/2013 23:31

Bottom Sampler Fairweather Fairweather 3/19/2013 BS 3 N/A Active 3/19/2013 23:32

Bottom Sampler Fairweather Fairweather 3/19/2013 BS 4 N/A Active 3/19/2013 23:34



type use owner current_location effective_date transaction_description manufacturer component model_number operating_system serial_number cd_number auv_system_compatibility status part_number service_tag bit install_date purchase_date rebuild_date processor_speed ram video_card video_ram mac_address comments

Desktop Acquisition Fairweather FA_2805 4/4/2013 VFD for HSRR 2013 Cybertron CPU PC ACP‐4000 XP Pro 2002 SP3 KM0169274 CD0001703149 Active ACP‐4000MB‐00XE 4.00E+12 32 2.0 GHz 3 GB 2 1024 MB

Desktop Acquisition Fairweather FA_2808 4/2/2013 VFD for HSRR 2013. Cybertron CPU PC ACP‐4000 XP Pro 2002 SP3 N/A CD0001703147 Active ACP‐4000MB‐00XE 4.00E+13 32 2.0 GHz 3 GB 2 1024 MB Has USB 3.0 and front loading e‐sata slot. Being upgraded to Win7 for 2013.

Desktop Acquisition Fairweather Fairweather 3/21/2013 Cybertron CPU PC ACP‐4000 XP Pro 2002 SP3 N/A CD0001703148 Active ACP‐4000MB‐00XE 4.00E+13 32 2.0 GHz 3 GB 1 1024 MB 2805

Desktop Acquisition Fairweather Fairweather 3/21/2013 Cybertron CPU PC ACP‐4000 XP Pro 2002 SP3 KMA0171609 CD0001703146 Active  ACP‐4000MB‐00XE 4.00E+13 32 2.0 GHz 3 GB 2 1024 MB 2807/P3

Desktop Acquisition Fairweather Fairweather 3/21/2013 Dell CPU Precision T3400 Win7 Pro N/A CD0001766763 Active HG7LWK1 64 3.33 GHz 3 GB 3 512 MB ACQ2

Desktop Acquisition Fairweather Fairweather 3/21/2013 Dell CPU Precision T3400 Win7 Pro N/A CD0001615444 Active CSH8NF1 64 3.0 GHz 3 GB 2 512 MB ACQ 1

Desktop Acquisition Fairweather Fairweather 3/21/2013 MVP‐C1‐2001 CPU MVP‐C1‐2001 Win7 Pro 10330 CD0001269854 Active 64 2.4 GHz 230 MB 2 64 MB P1

Laptop Acquisition Fairweather Rainier 1/28/2014 Sent to RA for data acquisition. Panasonic Toughbook CF‐30 XP Pro 2002 SP3 N/A CD0001447101 Active 8HKSB80631 32 1.7 GHz 1 GB 0 384 MB P1

Laptop Acquisition Fairweather Rainier 1/28/2014 Sent to RA for data acquisition. Panasonic Toughbook CF‐30 XP Pro 2002 SP3 N/A CD0001447100 Active 8HKSB80630 32 1.7 GHz 1 GB 1 384 MB P1

Laptop Acquisition Fairweather Fairweather 3/21/2013 Panasonic Toughbook CF‐18 XP Pro 2002 SP3 N/A CD0001269860 Active 4HKSA59499 32 1.1 GHz 2.5 GB 2 64 MB ET

Laptop Acquisition Fairweather Fairweather 3/21/2013 Panasonic Toughbook CF‐18 XP Pro 2002 SP3 N/A CD0001269858 Active 4HKSA59560 32 1.1 GHz 2.5 GB 1 64 MB P1

Laptop Acquisition Fairweather Fairweather 3/21/2013 Panasonic Toughbook CF‐19 XP Pro 2002 SP3 N/A CD0001696424 Active 9AKSB43281 32 1.1 GHz 1 GB 0 384 MB P1

Laptop Acquisition Fairweather Fairweather 3/21/2013 Panasonic Toughbook CF‐29 XP Pro 2002 SP3 N/A CD0001698251 Active 6AKSB06863 32 1.6 GHz 2.5 GB 1 128 MB P1

Other Acquisition Fairweather Fairweather 2/26/2013 PCTEL UHF Antenna MAX9053 N/A Active

UHF Antenna Acquisition Fairweather Fairweather 2/26/2013 PCTEL UHF Radio MAX9053 XXX3 Unknown Active

UHF Radio Acquisition Fairweather FA_2805 4/4/2013 VFD for HSRR 2013 FreeWave UHF Radio HTP‐900RE 885‐8740 CD0001709330 Active 00:07:E7:87:2C:74 IP Address: 10.48.19.58

UHF Radio Acquisition Fairweather FA_2808 4/2/2013 VFD for HSRR 2013. FreeWave UHF Radio HTP‐900RE 884‐9301 Unknown Active IP Address: 10.48.19.57. P004369.

UHF Radio Acquisition Fairweather Fairweather 2/26/2013 FreeWave UHF Radio HTP‐900RE 884‐9190 CD0001526971 Active

UHF Radio Acquisition Fairweather Fairweather 2/26/2013 FreeWave UHF Radio HTP‐900RE 886‐0745 CD0001526975 Active

UHF Radio Acquisition Fairweather Fairweather 2/26/2013 FreeWave UHF Radio HTP‐900RE 884‐9511 Unknown Active 00:07:E7:87:08:67 P004370

UHF Radio Acquisition Fairweather Fairweather 2/26/2013 FreeWave UHF Radio HTP‐900RE 886‐0744 CD0001526976 Active 00:07:E7:87:34:49

UHF Radio Acquisition Fairweather Fairweather 2/26/2013 FreeWave UHF Radio HTP‐900RE 885‐8156 CD0001709328 Active 00:07:E7:87:2A:2C

UHF Radio Acquisition Fairweather Fairweather 2/26/2013 FreeWave UHF Radio HTP‐900RE 885‐8689 Unknown Active 00:07:E7:87:2C:41

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001766764 Active JG7CWK1 64 3.33 GHz 3 GB 2 512 MB P3‐P2

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001766791 Active GZ55K1 64 3.33 GHz 3 GB 2 512 MB P3‐P3

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001615470 Active DHKCZF1 64 3.0 GHz 3 GB 2 512 MB P2

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001766914 Active FJKBZK1 64 3.33 GHz 3 GB 2 512 MB P3‐P1

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001775170 Active GV1SSR1 64 3.33 GHz 3 GB 2 512 MB P1‐P1

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001766765 Active 1H7CWK1 64 3.33 GHz 3 GB 2 512 MB O ‐lab

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001775171 Active GV1YSR1 64 3.33 GHz 3 GB 2 512 MB P1‐P8

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001775169 Active GV23TR1 64 3.33 GHz 3 GB 2 512 MB P1‐P9

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3500 Win7 Pro N/A CD0001775166 Active GVR1RSR1 64 3.33 GHz 3 GB 2 512 MB P1‐P6

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3500 Win7 Pro N/A CD0001775165 Active GVR1RSR1 64 3.33 GHz 3 GB 2 512 MB P1‐P3

Desktop Processing Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3500 Win7 Pro N/A CD0001775172 Active GV1V1ZSR1 64 3.33 GHz 3 GB 2 512 MB P1‐P2

Desktop Processing Fairweather Fairweather 9/1/2013 Retained in DP3 for 2013 Winter. Dell Workstation Precision T3400 Win7 Pro N/A CD0001766792 Active HZ55ZK1 64 3.33 GHz 3 GB 2 512 MB FA‐DP3‐P3

Desktop Processing Fairweather Fairweather 9/1/2013 Moved to DP3 Location for 2013 Winter. Dell Workstation Precision T3500 Win7 Pro N/A CD0001684476 Active 5N55KN1 64 3.33 GHz 12 GB 2 512 MB FA‐DP3‐P2

Desktop Processing Fairweather Fairweather 9/1/2013 Moved to DP3 Location for 2013 Winter. Dell Workstation Precision T3500 Win7 Pro N/A CD0001684477 Active 3MD5KN1 64 3.33 GHz 12 GB 2 512 MB FA‐DP3‐P1

Desktop Processing Fairweather Fairweather 9/1/2013 Moved to DP3 Location for 2013 Winter. Dell Workstation Precision T3500 Win7 Pro N/A CD0001684478 Active 3MD4KN1 64 3.33 GHz 12 GB 2 512 MB FA‐DP3‐P4

Desktop Processing Fairweather Fairweather 7/29/2013 Computer transferred to FA for use in 2013 Field Season. Dell Workstation T5600 Win7 64bit 9T0MFX1 CD0001769814 Active 9T0MFX1 64 5/23/2013 2.4 GHz (2 Quad Core Processors) 8GB AMD FirePro V5900 2GB FA‐P4

Desktop Processing Fairweather Fairweather 7/29/2013 Computer transferred to FA for use in 2013 Field Season. Dell Workstation T5600 Win7 64bit 9SZJFX1 CD0001769812 Active 9SZJFX1 64 5/23/2013 2.4 GHz (2 Quad Core Processors) 8GB AMD FirePro V5900 2GB FA‐P5

Desktop Processing Fairweather Fairweather 7/29/2013 Computer transferred to FA for use in 2013 Field Season. Dell Workstation T5600 Win7 64bit 9SYLFX1 CD0001769811 Active 9SYLFX1 64 5/23/2013 2.4 GHz (2 Quad Core Processors) 8GB AMD FirePro V5900 2GB FA‐P6

Desktop Processing Fairweather Fairweather 7/29/2013 Computer transferred to FA for use in 2013 Field Season. Dell Workstation T5600 Win7 64bit 9T0LFX1 CD0001769813 Active 9T0LFX1 64 5/23/2013 2.4 GHz (2 Quad Core Processors) 8GB AMD FirePro V5900 2GB FA‐P7

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1703FP1 CN‐02Y3157161843RAJF2 CD0001698294 Active O‐Lab

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1703FPS CN‐02Y3114760645MAD7D CD0001698297 Active P2

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1703FPS MX‐02Y3114760549EAL60 CD0001698288 Active ACQ

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1703FPT CN‐02Y31571661843RAJZL CD0001698298 Active P2

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1703FPT CN‐02Y3157161843RAAXA CD0001698296 Active ACQ

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1800FP MX‐07R4774832338r0525 CD0001703143 Active P3‐P2

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1800FP MX‐07R4744832338R04NT CD0001698318 Active P3‐P4

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1800FP MX‐07R4774832378R04NR CD0001698320 Active P3‐P4

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1800FP MX‐0W86904832353N1TSA CD0001698310 Active P3‐P3

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QAKKA CD0001698271 Active O‐Lab

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QAL8H CD0001688262 Active P1‐P9

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QAL8F CD0001688263 Active P1‐P9

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QALKT CD0001698265 Active P1‐P8

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845EACLO CD0001698264 Active P1‐P8

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845PBA8G CD0001698273 Active P1‐P6

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845PBA8P CD0001698272 Active P1‐P6

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QAL83 CD0001698279 Active P1‐P3

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845qALT1 CD0001698278 Active P1‐P3

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845PBAFW CD0001698277 Active P1‐P4

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161846ABDDO CD0001698276 Active P1‐P4

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845PBAFK CD0001698281 Active P1‐P2

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QALKV CD0001698280 Active P1‐P2

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161842DBAQV CD0001698283 Active P1‐P1

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845PBA8N CD0001698282 Active P1‐P1

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐0T6116716184C9AAGF CD0001698266 Active P1‐P7

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP MX‐0G454H7444697SA69L CD0001721848 Active P1‐P7

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QA738 CD0001698285 Active ACQ

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QALT3 CD0001698284 Active ACQ
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Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845PBASE CD0001698287 Active ACQ

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1901FP CN‐05Y2327161845QA732 CD0001698286 Active ACQ

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1905FP MX‐07R47748323438R052A CD0001698302 Active P3‐P3

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1905FP CN‐0T6116716185CHAFRH CD0001698303 Active P3‐P2

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1905FP CN‐0T6116716184C9AA05 CD0001698304 Active P3‐P1

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1905FP MX‐0186904832353N1SYA CD0001698305 Active P3‐P1

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1905FP MX‐0W869048323h3N18WA CD0001698275 Active P1‐P5

Monitor Processing Fairweather Fairweather 3/21/2013 Dell 1905FP CN‐0T6116716184C9AAGG CD0001698274 Active P1‐P5

Monitor Processing Fairweather Fairweather 3/21/2013 Dell E152FP2 CN‐0M16196418045J0W0H CD0001709338 Active ACQ

Desktop Support Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001766754 Active 7G7CWK1 64 3.33 GHz 3 GB 2 512 MB FOO

Desktop Support Fairweather Fairweather 3/21/2013 Dell CPU  Precision T3400 Win7 Pro N/A CD0001766913 Active DJKBZK1 64 3.33 GHz 3 GB 2 512 MB CST

Monitor Support Fairweather Fairweather 3/21/2013 Dell 1901FP MX‐0G454H7444697SA70L CD00017221841 Active CST

Monitor Support Fairweather Fairweather 3/21/2013 Dell 1901FP MX‐0G454H7444697SABCL CD0001722052 Active FOO

Monitor Support Fairweather Fairweather 3/21/2013 Dell 1901FP MX‐0G454H7444697SA5NL CD0001721847 Active FOO

Monitor Support Fairweather Fairweather 3/21/2013 Dell 1905FP CN‐05Y2327161845QA733 CD0001698268 Active CST

UHF Radio Fairweather Fairweather 3/6/2013 Pacific Crest PDL 4135 0424 0154 CD0001269910 Active A01334 Position Data Link High Powered Base Unit

UHF Radio Fairweather Fairweather 3/6/2013 Pacific Crest PDL 4135 0347 3047 CD0001269896 Active A01337 Position Data Link Rover

UHF Radio Fairweather Fairweather 3/6/2013 Pacific Crest PDL 4135 0424 0155 CD0001269912 Active A01337 Position Data Link Rover

UHF Radio Fairweather Fairweather 3/6/2013 Pacific Crest PDL 4135 0709 5939 CD0001269911 Active A01337 Position Data Link Rover

UHF Radio Fairweather Fairweather 3/6/2013 Pacific Crest PDL 4135 0424 0171 CD0001269910 Active A01334 Position Data Link High Powered Base Unit



type owner current_location manufacturer component system model_number serial_number frequency frequency_unit cd_number status firmware_version comments

Multibeam Echosounder Fairweather EEB (West) Reson Transducer 7111 Wet end EM 7187 Rx 5008001 100 kHz CD0001065312 Needs Repair
Serial #:  5008001(EM7187‐Rx) Tracked with CD0001065312. Tx & Rx removed in 
December 2012 drydock and sent back to Reson for re‐molding to then have a 
fleet spare.

Multibeam Echosounder Fairweather FA_2805 Reson Processor 7125 SV1 1812027 CD0001529685 Active UNH calibrated sonar 2011.
Multibeam Echosounder Fairweather FA_2805 Reson Receiver 7125 SV1 EM 7200 3008265 CD0001776106 Active
Multibeam Echosounder Fairweather FA_2805 Reson Transducer 7125 SV1 TC 2160 4008071 400 kHz CD0001776105 Active 8/16/13 ‐ RMA 510062  ‐ See TPU (1812028 for comments)
Multibeam Echosounder Fairweather FA_2805 Reson Transducer 7125 SV1 TC 2163 4408358 200 kHz Unknown Active
Side Scan Sonar Fairweather FA_2805 Klein TPU 5000 V1 138 455 kHz CD0000825294 Active MOC‐A # A011734
Multibeam Echosounder Fairweather FA_2806 Reson Processor 7125 SV1 1812020 CD0001527818 Active Feature Pack 1.3.2 UNH calibrated sonar 2012.
Multibeam Echosounder Fairweather FA_2806 Reson Receiver 7125 SV1 EM 7200 309012 Unknown Active
Multibeam Echosounder Fairweather FA_2806 Reson Transducer 7125 SV1 TC 2160 2208007 400 kHz Unknown Active
Multibeam Echosounder Fairweather FA_2806 Reson Transducer 7125 SV1 TC 2163 2409098 200 kHz Unknown Active

Multibeam Echosounder Fairweather FA_2807 Reson Processor 7125 SV1 1812023 CD0001529704 Active Needs update to 
Feature Pack 1.3.2

Multibeam Echosounder Fairweather FA_2807 Reson Receiver 7125 SV1 EM 7200 309019 Unknown Active UNH calibrated sonar 2011.
Multibeam Echosounder Fairweather FA_2807 Reson Transducer 7125 SV1 TC 2160 2308110 400 kHz Unknown Active UNH Calibrated sonar 2011.
Multibeam Echosounder Fairweather FA_2807 Reson Transducer 7125 SV1 TC 2163 4408351 200 kHz Unknown Active UNH calibrated sonar 2011.
Side Scan Sonar Fairweather FA_2807 Klein TPU 5000 V1 176 455 kHz CD0001527021 Active
Multibeam Echosounder Fairweather FA_2808 Reson Processor 7125 SV1 1812028 CD0001529714 Active Feature Pack 1.3.2
Multibeam Echosounder Fairweather FA_2808 Reson Receiver 7125 SV1 EM 7200 309014 Unknown Active UNH calibrated sonar 2012.
Multibeam Echosounder Fairweather FA_2808 Reson Transducer 7125 SV1 TC 2160 1908209 400 kHz Unknown Active UNH calibrated sonar 2012.

Multibeam Echosounder Fairweather FA_2808 Reson Projector 7125 SV1 TC 2163 85000327 200 kHz Unknown Active New Projector purchased February 2014 to replace unit condemned by Reson 
with the bubble on the transducer face and water intrusion. 

Side Scan Sonar Fairweather FA_2808 Klein TPU 5000 V1 166 CD0001722042 Active MOC‐A# A014614. Bay Hydro Label.

Multibeam Echosounder Fairweather Fairweather Reson Processor 7111 2009003 100 kHz CD0001065312 Active

7k UI: 3.11.2.2
7k Center: 3.4.5.3
7kIO: 3.7.0.14
Updated Summer 2013

Multibeam Echosounder Fairweather Fairweather Reson Receiver 7111 EM 7187 1409093 100 kHz Unknown Needs Repair Refurbished unit.

Multibeam Echosounder Fairweather Fairweather Reson Transducer 7111 TC 2126‐3 4608498 100 kHz Unknown Active
Previously used unit from RESON. $130,000 purchase price. Replacement 7111 Tx 
purchased from RESON to replace FA unit in need of remolding and repair.

Multibeam Echosounder Fairweather Fairweather Reson Transducer 7125 SV1 TC 2163 1008117 200 kHz Unknown Consumed

UNH calibrated sonar 2012.
8/16/13 ‐ RMA 510062 ‐ 200 KHz Projector does transmit an acoustic pulse. 
However, the 200 KHz Projector is no longer within specifications and may 
damage the  Processor it used. This is due to Water intruding past the O‐Rings 
and corrosion of the internal core that supports the ceramics.

Multibeam Echosounder Fairweather Fairweather Reson Processor 8125 31562 455 kHz CD0000825308 Spare 8125‐2.10‐A50F Transferred to the FA. Sunflower location = C‐02

Multibeam Echosounder Fairweather Fairweather Reson Processor 8160 5385 50 kHz CD0001065313 Active 8160‐2.09‐7C6D

Multibeam Echosounder Fairweather Fairweather Reson Transceiver Boards 8160 35028 Unknown Active Tracked with CD0001065313. P/N 85108051, RMA# 501210
Multibeam Echosounder Fairweather Fairweather Reson Transducer 8160 FA‐8160 50 kHz Unknown Active
Side Scan Sonar Fairweather Fairweather Klein Towfish 5000 Heavy Weight 292 Unknown Active

Side Scan Sonar Fairweather Fairweather Klein Towfish 5000 Heavy Weight 293 455 kHz CD0000825404 Active RA put this piece into MOC‐P Warehouse 23 Apr 2013 for shipment to FA. Also 
listed AMC #A0052852 ‐Curran Mcbride

Side Scan Sonar Fairweather Fairweather Klein Towfish 5000 Heavy Weight 5410 260 455 kHz Unknown Active RA put this piece into MOC‐P Warehouse 23 APR 2013 for shipment to FA.‐ C. 
Mcbride

Side Scan Sonar Fairweather Fairweather Klein Towfish 5000 Light Weight 321 455 kHz CD0001709343 Active
Side Scan Sonar Fairweather Fairweather Klein TPU 5000 V1 177 455 kHz CD0001527022 Active
Single Beam Echosounder Fairweather Fairweather CEE HydroSystems Transducer 0238‐10468‐0004 200 kHz Unknown Active
Single Beam Echosounder Fairweather Fairweather Teledyne Odom Hydrographic Transducer SMBB200_4A TR5162 200 kHz Active 4 Degree (large)
Single Beam Echosounder Fairweather Fairweather Teledyne Odom Hydrographic Transducer SMBB200_4A TR5159 200 kHz Active 4 Degree (large)
Single Beam Echosounder Fairweather Fairweather Teledyne Odom Hydrographic Transducer SMBB200_9 TR5138 200 kHz Active 9 Degree (small)
Single Beam Echosounder Fairweather Fairweather Teledyne Odom Hydrographic Transducer SMBB200_9 TR5139 200 kHz Active 9 Degree (small)
Single Beam Echosounder Fairweather Fairweather Teledyne Odom Hydrographic System Echotrac CVM‐A 26034 CD0001703210 Active 4.01 Chart view Dongle (100.001.001.098)
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Base Station Equipment Fairweather Fairweather Ashtech GPS Antenna Geodetic 4 8365 Active 701975‐01 used in field, for static positioning of benchmarks

Base Station Equipment Fairweather Fairweather Ashtech GPS Receiver Z‐Xtreme ZE1200339016 CD0001062363 Active 800889

Base Station Equipment Fairweather Fairweather GE Energy Solar Panel GEPV‐030‐MNA‐001 C30G200506210063 Active

Base Station Equipment Fairweather Fairweather Morningstar Solar Charger SS‐10‐L. 12v 10331024 Active Erine‐ Orange Box

Base Station Equipment Fairweather Fairweather Morningstar Solar Charger SS‐10‐L. 12v 10190179 Active Bert‐ Yellow Pelican Box

Base Station Equipment Fairweather Fairweather Morningstar Solar Charger SS‐10‐L. 12v 10190178 Active Oscar‐ Black Pelican Box

Base Station Equipment Fairweather Fairweather Morningstar Solar Charger SS‐10‐L. 12v 10190177 Spare Spare‐ Tan Pelican Case

Base Station Equipment Fairweather Fairweather PWM Solar Charger EPRC5 0702EPRC5‐026 Active

Base Station Equipment Fairweather Fairweather PWM Solar Charger EPRC5 XXX1 Active

Base Station Equipment Fairweather Fairweather PWM Solar Charger EPRC5 XXX2 Active

Base Station Equipment Fairweather Fairweather Sunlinq Solar Panel P3‐12V‐60 146624 Active

Base Station Equipment Fairweather Fairweather Sunlinq Solar Panel P3‐12V‐60 146636 Active

Base Station Equipment Fairweather Fairweather Trimble GPS Receiver NetR5 4910K61054 CD0001526973 Active 4.03 4/30/2009 7/17/2009 3/14/2013 aka "Oscar," Firmware Warranty Expiration Date:  2010‐08‐01

Base Station Equipment Fairweather Fairweather Trimble GPS Receiver NetR9 5034K69677 CD0001709320 Active 4.43 8/23/2011 10/25/2010 3/12/2013 aka "Ernie," Firmware Warranty Expiration Date:  2012‐02‐01

Base Station Equipment Fairweather Fairweather Trimble GPS Receiver NetR9 5034K69698 CD0001709319 Active 4.43 8/23/2011 9/15/2010 3/13/2013 aka "Bert," Firmware Warranty Expiration Date:  2012‐02‐01

Base Station Equipment Fairweather Fairweather Trimble GPS Receiver DSM 232 225111661 CD0001697439 Active 60232‐00 RTK capable

Base Station Equipment Fairweather Fairweather Trimble GPS Receiver DSM 232RS 225111655 CD0001697422 Active

Base Station Equipment Fairweather Fairweather Trimble GPS Receiver MS 750 220339262 CD0001478898 Active 36487‐02 RTK capable

Base Station Equipment Fairweather Fairweather Trimble GPS Antenna Zephyr Geodetic 12297641 Active Zezula brought antenna from AK Nav

Base Station Equipment Fairweather Fairweather Trimble GPS Antenna Zephyr Geodetic 2 30325441 Active 55971‐00DC4703

Base Station Equipment Fairweather Fairweather Trimble GPS Antenna Zephyr Geodetic 2 1441027807 Active 57971‐00DC5031 Bert ‐ Yellow box

Base Station Equipment Fairweather Fairweather Trimble GPS Antenna Zephyr Geodetic 2 1441031361 Active 57971‐00DC5034  Ernie ‐ Orange box

Base Station Equipment Fairweather Fairweather Trimble GPS Antenna Zephyr Geodetic 2 30767996 Active 57971‐00DC4807 Oscar ‐ Black box

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel FLX 32 USF‐32‐14639 Active

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel FLX 32 USF‐32‐14634 Active

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel FLX 32 USF‐32‐14633 Active

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel FLX 32 USF‐32‐14529 Active

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel FLX 32 USF‐32‐14525 Active

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel FLX 32 USF‐32‐14631 Active

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel MBC 525 525‐011607 CD000684512 Active

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel MBC 525 525‐011589 CD000684510 Active

Base Station Equipment Fairweather Fairweather Uni‐Solar Solar Panel MBC 525 525‐011093 CD000684507 Active

Level Fairweather Fairweather Carl Zeiss Level Ni2 103267 Unknown Active 3/27/2013 3/13/2014 from W‐COOPS, calibrated yearly. 333 Stadia

Level Fairweather Fairweather Carl Zeiss Level Ni2 100056 Unknown Active 1/27/2014 10/27/2012 from W‐COOPS, calibrated yearly. 333 stadia

Level Fairweather Fairweather Leica Level NA2 100 5332739 Unknown Spare 1/27/2014 10/27/2012 Spare, calibrated bi‐annually

Level Fairweather Fairweather Leica Level NA2 100 5332747 Unknown Spare 1/27/2014 10/27/2012 Spare, calibrated bi‐annually

Rover Equipment Fairweather Fairweather Trimble Data Logger TSCe 37318 CD0001709309 Active 45268‐50 Handheld data collector
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Lead Line Fairweather Fairweather 2/26/2013 FA Personnel Traditional 10_01_05 Active 10m Lead Line 2/26/2013 18:02
Lead Line Fairweather Fairweather 2/26/2013 FA Personnel Traditional 10_02_05 Active 10m Lead Line 2/26/2013 18:02
Lead Line Fairweather Fairweather 2/26/2013 FA Personnel Traditional 20_01_05 Active 20m Lead Line 2/26/2013 18:03
Lead Line Fairweather Fairweather 2/26/2013 FA Personnel Traditional 20_02_05 Active 20m Lead Line 2/26/2013 18:03
Lead Line Fairweather Fairweather 2/26/2013 FA Personnel Traditional 20_03_05 Active 20m Lead Line 2/26/2013 18:03
Lead Line Fairweather Fairweather 2/26/2013 FA Personnel Traditional 30_01_05 Active 30m Lead Line 3/5/2013 17:41
Lead Line Fairweather Fairweather 2/26/2013 FA Personnel V‐100/Non‐Traditiona 10_05_09 Active 10m Lead Line 2/26/2013 18:03
Lead Line Fairweather Fairweather 2/26/2013 FA Personnel V‐100/Non‐Traditiona 10_06_XX Active 10m Lead Line 2/26/2013 18:03
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GPS Equipment Fairweather Fairweather Trimble Receiver Pathfinder Pro XRS 224078543 CD0001269835 Active 33302‐53  GPS receiver

GPS Equipment Fairweather Fairweather Trimble Receiver Pathfinder Pro XRS 224090101 CD0001269836 Active 33302‐53

DGPS Equipment Fairweather FA_2805 Hemisphere Receiver MBX‐4 0927‐9567‐0001 CD0001709331 Active 801‐3012‐000

GPS Equipment Fairweather FA_2805 Trimble Antenna Zephyr II 311717272 Unknown Active 57970‐00 DC4905 Port Primary  POS MV Port Antenna

GPS Equipment Fairweather FA_2805 Trimble Antenna POS MV 320 V4 Zephyr II 5000100665 N/A Active 8/16/2013 Starboard Secondary

Positioning & Attitude System Equipment Fairweather FA_2805 Applanix IMU LN 200 294 CD0001696449 Active  10001506‐4 4/1/2003 Last tumble test date: Jan/Feb2010
Last known location: FA Launch 2805

Positioning & Attitude System Equipment Fairweather FA_2805 Applanix PCS POS MV 320 V4 2411 CD0001697462 Active 1/1/2008 BD960 Has 4GB of Internal Logging.

GPS Equipment Fairweather FA_2806 Trimble Antenna POS MV 320 V4 Zephyr II 5000101101 N/A Active 8/19/2013 8/16/2013

GPS Equipment Fairweather FA_2806 Trimble Antenna POS MV 320 V4 Zephyr II 5000101022 N/A Active 8/19/2013 8/16/2013

Positioning & Attitude System Equipment Fairweather FA_2806 Applanix IMU LN 200 991 CD0001722214 Active 4/1/2010 Last tumble test date: NEW April 2010
Last known location: Fairweather

Positioning & Attitude System Equipment Fairweather FA_2806 Applanix PCS POS MV 320 V4 2560 CD0001601274 Active PCS‐29 HW2.6‐7, SW04.22, POS Cntrlr v. 
4.3.4.0

11/7/2006 BD960 Upgraded to Internal logging with 4GB March 2012.

GPS Equipment Fairweather FA_2807 Trimble Antenna Zephyr II 1440925095 N/A Active 57970‐00 DC4928 8/21/2013

Positioning & Attitude System Equipment Fairweather FA_2807 Applanix PCS POS MV 320 V4 3628 CD0001527796 Active PCS‐29 HW4.1‐7, SW05.01, POS Cntrlr 
v.5.1.0.2

8/8/2009 BD960 Upgraded to Internal logging March 2012. New primary receiver card 
June 2013.

DGPS Equipment Fairweather FA_2808 Hemisphere Receiver MBX‐4 0923‐9416‐0007 P004425 Active 801‐3012‐000

GPS Equipment Fairweather FA_2808 Trimble Antenna Zephyr II 1440904832 Unknown Active 57970‐00 DC4911 Port Primary  POS MV Port Antenna

GPS Equipment Fairweather FA_2808 Trimble Antenna Zephyr II 31177272 Unknown Active Starboard Secondary

Positioning & Attitude System Equipment Fairweather FA_2808 Applanix IMU LN 200 324 CD0001722041 Active 10001506‐4 4/1/2003 Last tumble test date: Unknown

Positioning & Attitude System Equipment Fairweather FA_2808 Applanix PCS POS MV 320 V4 2564 CD0001601275 Active HW2.6‐7, SW04.22 , POS Cntrlr 
v.4.3.4.0

11/7/2006 BD960 Upgraded to 4GB Internal logging.

DGPS Equipment Fairweather Fairweather CSI Wireless Receiver MBX‐3S 0324‐11969‐0002 CD0001065375 Active

DGPS Equipment Fairweather Fairweather CSI Wireless Receiver MBX‐3S 0328‐12362‐0001 CD10652291 Active

DGPS Equipment Fairweather Fairweather CSI Wireless Antenna MGL3 0328‐12352‐0002 Active   Antenna

DGPS Equipment Fairweather Fairweather CSI Wireless Antenna MGL3 9824‐1779‐0002 Active   Antenna

DGPS Equipment Fairweather Fairweather Hemisphere Antenna MA40 0924‐9488‐0040 Active 804‐3029‐000   Antenna

DGPS Equipment Fairweather Fairweather Hemisphere Antenna MA40 0919‐9231‐0191 Active 804‐3029‐000   Antenna

DGPS Equipment Fairweather Fairweather Hemisphere Antenna MA40 0919‐9231‐0193 Active 804‐3029‐000

DGPS Equipment Fairweather Fairweather Hemisphere Antenna MA40 0924‐9488‐0046 Active 804‐3029‐000

DGPS Equipment Fairweather Fairweather Hemisphere Receiver MBX‐4 0923‐9416‐0005 CD0001709329 Active 801‐3012‐000 

DGPS Equipment Fairweather Fairweather Hemisphere Receiver MBX‐4 0924‐9498‐000 Active 801‐3012‐000

GPS Equipment Fairweather Fairweather NavCom Antenna AN‐2004T 7020 Active 82‐001000‐3004

GPS Equipment Fairweather Fairweather NavCom Receiver SF‐2050G 5086 CD0001699203 Active 92‐310059‐3001

GPS Equipment Fairweather Fairweather NavCom Receiver SF‐2050R 5012 CD0001697402 Active 92‐310059 Net 1&2 capable only

GPS Equipment Fairweather Fairweather Trimble Antenna 220321059 Active  33580‐50

GPS Equipment Fairweather Fairweather Trimble Antenna  33580‐50 220341062 Active

GPS Equipment Fairweather Fairweather Trimble Antenna 33580‐00  220395038 Active 33580‐00

GPS Equipment Fairweather Fairweather Trimble Antenna OEM2 3151R 60145158 Active  POS MV Antenna

GPS Equipment Fairweather Fairweather Trimble Antenna OEM2 3151R 60268090 Active  POS MV Antenna

GPS Equipment Fairweather Fairweather Trimble Antenna SPS MSK 5876 Active 44530‐00REV.A

GPS Equipment Fairweather Fairweather Trimble Antenna Trimble Micro Centered L1/L2 220298707 Active 33429‐00

GPS Equipment Fairweather Fairweather Trimble Antenna Zephyr I 60125191 N/A Spare 8/21/2013

GPS Equipment Fairweather Fairweather Trimble Antenna Zephyr I 60130644 N/A Consumed 39105‐00 DC4604 Starboard  POS MV Stbd Antenna. Failure and no longer in service.

GPS Equipment Fairweather Fairweather Trimble Antenna Zephyr I 60078644 N/A Spare 39105‐00 DC4521

GPS Equipment Fairweather Fairweather Trimble Antenna Zephyr II 31180200 Active 57970‐00 DC 4845 Starboard  POS MV Stbd Antenna. On permanent loan from Rainer.

GPS Equipment Fairweather Fairweather Trimble Antenna Zephyr II 1440912566 Active 57970‐00 DC4920 Starboard  POS MV Stbd Antenna

GPS Equipment Fairweather Fairweather Trimble Antenna Zephyr II 1440941041 N/A Lost 57970‐00 DC4947

GPS Equipment Fairweather Fairweather Trimble Antenna Zephyr II 1440904133 N/A Active 57970‐00 DC 4911 Port  POS MV Port Antenna. On permanent loan from Rainer.

GPS Equipment Fairweather Fairweather Trimble Antenna Zephyr II 31185275 Unknown Consumed 57970‐00 DC4905 Starboard Secondary Currently in CST Desk.

GPS Equipment Fairweather Fairweather Trimble Antenna POS MV 320 V4 Zephyr II 5000101124 N/A Spare 8/16/2013 In CST Desk.

GPS Equipment Fairweather Fairweather Trimble Antenna POS MV 320 V4 Zephyr II 5000100734 N/A Spare 8/16/2013 In CST Desk.

GPS Equipment Fairweather Fairweather Trimble Antenna POS MV 320 V4 Zephyr II 5000101055 N/A Spare 8/16/2013 In CST Desk.

Positioning & Attitude System Equipment Fairweather Fairweather Applanix IMU LN 200 995 CD0001530026 Spare 4/1/2010 2/11/2014 passed 2/11/2014 2/11/2014 Last tumble test date: January 2014
Last known location: CET for storage

Positioning & Attitude System Equipment Fairweather Fairweather Applanix IMU LN 200 292 CD0001696450 Active 4/1/2003 2/1/2010 Last tumble test date: Jan/Feb2010
In use on S‐220.

Positioning & Attitude System Equipment Fairweather Fairweather Applanix PCS POS MV 320 V4 3627 CD0001527797 Active HW4.1‐7, SW05.01, POS Cntrlr 
v.5.1.0.2

8/8/2009 BD960 Upgraded to 4GB Internal Logging.

Rangefinder Fairweather Fairweather Laser Tech Impulse LR i09290 CD0001269812 Spare 7002700 3/12/2013

Rangefinder Fairweather Fairweather Laser Tech TruPulse 200 Laser Rangefinder 676 Active

Rangefinder Fairweather Fairweather Laser Tech TruPulse 200 Laser Rangefinder 41169 Active

Rangefinder Fairweather Fairweather Laser Tech TruPulse 200 Laser Rangefinder 41156 Active

Rangefinder Fairweather Fairweather Laser Tech TruPulse 200 Laser Rangefinder 1481 Active

TABLE positioning_attitude



use owner current_location manufacturer name license license_type license_expiration_date status version bit comments

Acquisition Fairweather Fairweather Hypack Survey/Hysweep 4565 Dongle Active 32 Licenses expire every year.

Acquisition Fairweather Fairweather Hypack Survey/Hysweep 4564 Dongle Active 32 Licenses expire every year.

Acquisition Fairweather Fairweather Hypack Survey/Hysweep 4563 Dongle Active 32 Licenses expire every year.

Acquisition and Processing Fairweather Fairweather Caris Suite CK9606815 Network Key Active 64 Licenses expire every year.

Acquisition and Processing Fairweather Fairweather Caris Suite CWSL100103 Soft License Active 64 Licenses expire every year.

Acquisition and Processing Fairweather Fairweather Hypack Survey/Hysweep/Geocoder 15686807 Dongle Active 32 Licenses expire every year.

Acquisition and Processing Fairweather Fairweather Hypack Survey/Hysweep/Geocoder 15686809 Dongle Active 32 Licenses expire every year.

Processing Fairweather Fairweather Applanix POSGNSS 7313 Dongle Active 32 Licenses expire every year.

Processing Fairweather Fairweather Applanix POSGNSS 9253 Dongle Active 64 Licenses expire every year.

Processing Fairweather Fairweather Applanix POSPac AV‐2692 Dongle Active 64 Licenses expire every year.

Processing Fairweather Fairweather Applanix POSPac MMS 4197 Dongle Active 64 Licenses expire every year.

Processing Fairweather Fairweather Applanix POSPac MMS 2692 Dongle Active 32 Licenses expire every year.

Processing Fairweather Fairweather IVS 3D Fledermaus 1601472412 Dongle Active 64 Licenses expire every year.

Processing Fairweather Fairweather IVS 3D Fledermaus 1601472438 Dongle Active 64 Licenses expire every year.

TABLE computer_software



type owner current_location manufacturer component system model_number serial_number cd_number status part_number
firmware_versio
n

firmware_version_inst
all_date

purchase_date manufacturer_service_date comments

CTD Fairweather Sea‐Bird Electronics Sea‐Bird Electronics CTD SBE 19plus 19P36026‐4585 CD0001697254 Active 90385010 1/1/2004 2/8/2014 Titanium CTD good to 3500m depth. Slower sampling rate. 
Calibrated Annually. Sunflower lists acquisition date as 2001, but 

CTD Fairweather Sea‐Bird Electronics Sea‐Bird Electronics CTD SBE 19plus 19P36026‐4617 CD0001697251 Lost 1/1/2004 2/8/2014 Sunflower lists acquisition date as 2001, but believed to be later.

CTD Fairweather Sea‐Bird Electronics Sea‐Bird Electronics CTD SBE 19plus V2 19P75469‐7370 CD0001686726 Active 8/1/2013 2/8/2014

CTD Fairweather Sea‐Bird Electronics Sea‐Bird Electronics CTD SBE 19plus V2 19P50959‐6121 CD0001527777 Active v 2.5.2 2/8/2014 8/28/2008 2/8/2014

CTD Fairweather Sea‐Bird Electronics Sea‐Bird Electronics CTD CTD SBE 19plus V2 19P50959‐6122 CD0001527778 Active v 2.2.2 2/8/2014 8/28/2008 2/8/2014

MVP Fairweather Fairweather Rolls‐Royce MVP MVP 200 DU 10328 CD0001269854 Active

MVP Fairweather Fairweather Rolls‐Royce MVP MVP 200 DU 10330 CD0001269854 Active 10/4/2005

MVP Fairweather Fairweather Rolls‐Royce MVP Single Sensor Free Fall Fish 10329 Active MVP‐FFF‐SS‐32‐1

MVP Fairweather Fairweather Rolls‐Royce MVP Single Sensor Free Fall Fish 10478 Active MVP‐FFF‐SS‐32‐1

Sound Speed Sensor Fairweather EEB (West) AML Oceanographic Sound Speed Sensor MVP Smart SV+P 4986 N/A Spare 9/1/2012 Passed Calibration

Sound Speed Sensor Fairweather FA_2805 Reson Surface Sound Speed Sensor SVP 71 EM 7213 2008038 CD0001776104 Active 904‐63‐0833‐00 11/13/2009 7/14/2009

Sound Speed Sensor Fairweather FA_2806 Reson Surface Sound Speed Sensor SVP 71 EM 7213 2008016 N/A Active 904‐63‐0833‐00 11/13/2009 10/8/2009

Sound Speed Sensor Fairweather FA_2808 Reson Surface Sound Speed Sensor SVP 71 EM 7213 2008017 Unknown Active 904‐63‐0833‐00 11/13/2009 7/17/2013

Sound Speed Sensor Fairweather Fairweather AML Oceanographic Smart SV+P 5466 N/A Spare 3/20/2013 Located at FA ET cage for drydock period 

Sound Speed Sensor Fairweather Fairweather AML Oceanographic Sound Speed Sensor MVP Smart SV+P 5229 Active 3/20/2013 Passed Calibration.

Sound Speed Sensor Fairweather Fairweather Reson Surface Sound Speed Sensor SVP 70 EM 7211 512018 Unknown Active 904‐63‐0833‐00 6/3/2013 6/22/2012 New unit purchased in 2012. Not in Sunflower.

Sound Speed Sensor Fairweather Fairweather Reson Surface Sound Speed Sensor SVP 70 EM 7211 3013020 Unknown Spare 904‐63‐0833‐10 12/1/2013

Sound Speed Sensor Fairweather Fairweather Reson Surface Sound Speed Sensor SVP 71 EM 7213 2008024 Unknown Spare 904‐63‐0833‐00 11/13/2009 7/17/2013 Standing by as fleet spare while actual fleet spare is in use.

Sound Speed Sensor Fairweather OCS Staff Teledyne Odom Hydrographic DB 1200 98207 Unknown Active 7/3/2003 Real time SS sensor for 8125. AMC CD number. Previous S/N listed: 
98013‐041609

TSG Fairweather Fairweather Sea‐Bird Electronics SBE 45 TSG 4536628‐0117 Unknown Active 4536628 Micro Thermosalinograph. Not used for surveying at this time

TABLE sound speed



Inventory

Last Updated:
Fairweather Software Inventory

11/30/2014

CARIS
 

HIP
S/S

IP
S

CARIS
 

Note
book

CARIS
 B

at
hy 

Dat
ab

as
e

CARIS
 P

lo
t 

Com
pose

r
Pyd

ro
/V

el
oci

py

M
ap

in
fo

Appla
nix

 
POSPac

*
Ash

te
ch

 
Solu

tio
ns

Fle
der

m
au

s

Snag
It

Hyp
ac

k

Hyp
ac

k 
Geo

co
der

Hys
wee

p E
dito

r 

(M
B M

ax
)

Appla
nix

 
POSVie

w
Ver

ifi
ca

tio
n 

Dat
e

M
AC 

Addre
ss

es

Additi
onal

 

Com
m

en
ts

Net
work

 
Com

p

#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 5-Keys

FA P1 Process 1 8.1.10 4.0.0.5 5.2 14.5-1 (4665) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1

FA P1 Process 2 8.1.10 4.0.0.5 5.2 14.6 (4790) 11 6.2 SP2 2.7 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2

FA P1 Process 3 8.1.10 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3

FA P1 Process 4 8.1.10 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 B8:CA:3A:76:A1:E1 replaced 6/1/11 w/ 64bit machine FA-Proc4

FA P1 Process 5 8.1.10 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 18-03-73-37-AA-C0 replaced 6/1/11 w/ 64bit machine FA-Proc5

FA P1 Process 6 8.1.10 4.0.0.5 5.1.1 14.6 (4790) 6.2 SP2 2.7 7.3.5a 10.0.0 10/7/2014 B8:CA:3A:76:92:82 New 5/2012 FA-Proc6

FA P1 Process 7 8.1.10 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 B8:CA:3A:7F:93:A6 replaced 6/1/11 w/ 64bit machine FA-Proc7

8 1 10 4 0 0 5 5 2 14 6 (4790) 6 2 SP2 2 7 7 3 6 10 0 0 10/7/2014FA P1 Process 8 8.1.10 4.0.0.5 5.2 14.6 (4790) 6.2 SP2 2.7 7.3.6.a 10.0.0 10/7/2014 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8

FA P1 Process 9 8.1.10 4.0.9 5.1.1 14.6 (4790) 11 6.2 SP2 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9

FA CST 8.1.10 4.0.9 5.1.1 14.6 (4790) 11 6.2 SP2 7.3.6.a 10.0.0 13.0.0.6 10/7/2014 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST

FA FOO 8.1.10 4.0.9 5.2 14.6 (4790) 11 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO

FA CO 8.1.10 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 8.1.10 4.0.0.5 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1

FA P3 Process1 8.1.10 4.0.0.5 5.2 14.6 (4790) 10.5 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 B8:AC:6F:89:DE:4C New Machine 3/2010 Fa-P3-P1

FA P3 Process2 8.1.10 4.0.9 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 B8:AC:6F:8D:0D:CE New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2

FA P3 Process3 8.1.10 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 00:24:E8:3C:8A:30 New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3

FA P3 Process4 8.1.10 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 B8:AC:6F:89:E0:B4 New Machine 3/2010 Fa-P3-P4

FA O-LAB 8.1.10 4.0.9 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 00:24:E8:3C:49:08 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34

S220 Acq 2 12.2  (r3724) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012

2805 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 10/7/2014 00:13:3B:0E:5F:4B

2806 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 10/7/2014 00-13-3B-0D-F5-69

2807 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 5.1.0.1 10/7/2014 00:13:3B:0D:ED:1E To HI  on 7/1/11

2808 Acq 3.1.1.1 13.8  (r4311) 5.4 SP2 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 5.1.0.1 10/7/2014 00-13-3B-0D-ED-02

Mobile Station 8.1.8 3.1.1.0 4.0.9 5.2 13.8  (4512) 11 2.7 10.0.0 2010 10/7/2014 00-24-E8-B5-85-1D

Toughbook 2 3.1.1.0 12.9  (r4195) 10/7/2014 00-0B-97-27-72-92 Tides, Old

Toughbook 3 3.1.1.1 12.9  (r4195) 2.6 2009 10/7/2014 00-0B-97-33-1C-CD Some GPS Utilities, Old

Toughbook 4 3.1.1.1 12.2  (r3724) 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetoothg

Toughbook 5 3.1.1.1 12.9  (r4195) 10/7/2014 00-1B-D3-38-1B-02 Tides

Toughbook 6 3.1.1.1 12.2  (r3724) 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth

11/29/2014 Page 1 Software Inventory_2014_nov.xlsm



Inventory

Last Updated:
Fairweather Software Inventory

8/30/2014

CARIS
 

HIP
S/S

IP
S

CARIS
 

Note
book

CARIS
 B

at
hy 

Dat
ab

as
e

CARIS
 P

lo
t 

Com
pose

r
Pyd

ro
/V

el
oci

py

M
ap

in
fo

Appla
nix

 
POSPac

*
Ash

te
ch

 
Solu

tio
ns

Fle
der

m
au

s

Snag
It

Hyp
ac

k

Hyp
ac

k 
Geo

co
der

Hys
wee

p E
dito

r 

(M
B M

ax
)

Appla
nix

 
POSVie

w
Ver

ifi
ca

tio
n 

Dat
e

M
AC 

Addre
ss

es

Additi
onal

 

Com
m

en
ts

Net
work

 
Com

p

#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 5-Keys

FA P1 Process 1 8.1.8 4.0.0.5 5.2 14.5-1 (4665) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1

FA P1 Process 2 8.1.8 4.0.0.5 5.2 14.6 (4790) 11 6.2 SP2 2.7 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2

FA P1 Process 3 8.1.8 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3

FA P1 Process 4 8.1.8 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 B8:CA:3A:76:A1:E1 replaced 6/1/11 w/ 64bit machine FA-Proc4

FA P1 Process 5 8.1.8 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 18-03-73-37-AA-C0 replaced 6/1/11 w/ 64bit machine FA-Proc5

FA P1 Process 6 8.1.8 4.0.0.5 5.1.1 14.6 (4790) 6.2 SP2 2.7 7.3.5a 10.0.0 10/7/2014 B8:CA:3A:76:92:82 New 5/2012 FA-Proc6

FA P1 Process 7 8.1.8 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 B8:CA:3A:7F:93:A6 replaced 6/1/11 w/ 64bit machine FA-Proc7

FA P1 Process 8 8.1.8 4.0.0.5 5.2 14.6 (4790) 6.2 SP2 2.7 7.3.6.a 10.0.0 10/7/2014 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8

FA P1 Process 9 8.1.8 4.0.9 5.1.1 14.6 (4790) 11 6.2 SP2 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9

FA CST 8.1.8 4.0.9 5.1.1 14.6 (4790) 11 6.2 SP2 7.3.6.a 10.0.0 13.0.0.6 10/7/2014 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST

FA FOO 8.1.8 4.0.9 5.2 14.6 (4790) 11 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO

FA CO 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 8.1.8 4.0.0.5 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1

FA P3 Process1 8.1.8 4.0.0.5 5.2 14.6 (4790) 10.5 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 B8:AC:6F:89:DE:4C New Machine 3/2010 Fa-P3-P1

FA P3 Process2 8.1.8 4.0.9 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 B8:AC:6F:8D:0D:CE New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2

FA P3 Process3 8.1.8 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 00:24:E8:3C:8A:30 New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3

FA P3 Process4 8.1.8 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 B8:AC:6F:89:E0:B4 New Machine 3/2010 Fa-P3-P4

FA O-LAB 8.1.8 4.0.9 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 00:24:E8:3C:49:08 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34

S220 Acq 2 12.2  (r3724) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012

2805 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 10/7/2014 00:13:3B:0E:5F:4B

2806 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 10/7/2014 00-13-3B-0D-F5-69

2807 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 5.1.0.1 10/7/2014 00:13:3B:0D:ED:1E To HI  on 7/1/11

2808 Acq 3.1.1.1 13.8  (r4311) 5.4 SP2 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 5.1.0.1 10/7/2014 00-13-3B-0D-ED-02

Mobile Station 8.1.8 3.1.1.0 4.0.9 5.2 14.6 (4790) 11 2.7 10.0.0 2010 10/7/2014 00-24-E8-B5-85-1D

Toughbook 2 3.1.1.0 12.9  (r4195) 10/7/2014 00-0B-97-27-72-92 Tides, Old

Toughbook 3 3.1.1.1 12.9  (r4195) 2.6 2009 10/7/2014 00-0B-97-33-1C-CD Some GPS Utilities, Old

Toughbook 4 3.1.1.1 12.2  (r3724) 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth

Toughbook 5 3.1.1.1 12.9  (r4195) 10/7/2014 00-1B-D3-38-1B-02 Tides

Toughbook 6 3.1.1.1 12.2  (r3724) 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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#/Type of Licenses 10-Ntk,1-USB 2-USB 4-Ntk.1-USB Unlimited Unlimited 6 St Alone 2 USB Key ? 2-USB 25 5-Keys

FA P1 Process 1 8.1.7 4.0.0.5 5.2 14.5-1 (4665) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 BC-30-5B-E9-FF-0A New 5/2012 FA-Proc1

FA P1 Process 2 8.1.7 4.0.0.5 5.2 14.6 (4790) 11 6.2 SP2 2.7 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-31 New 5/2012 FA-Proc2

FA P1 Process 3 8.1.7 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-28 New 5/2012 FA-Proc3

FA P1 Process 4 8.1.7 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 B8:CA:3A:76:A1:E1 replaced 6/1/11 w/ 64bit machine FA-Proc4

FA P1 Process 5 8.1.7 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 18-03-73-37-AA-C0 replaced 6/1/11 w/ 64bit machine FA-Proc5

FA P1 Process 6 8.1.7 4.0.0.5 5.1.1 14.6 (4790) 6.2 SP2 2.7 7.3.5a 10.0.0 10/7/2014 B8:CA:3A:76:92:82 New 5/2012 FA-Proc6

FA P1 Process 7 8.1.7 4.0.9 5.1.1 14.6 (4790) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 B8:CA:3A:7F:93:A6 replaced 6/1/11 w/ 64bit machine FA-Proc7

FA P1 Process 8 8.1.7 4.0.0.5 5.2 14.6 (4790) 6.2 SP2 2.7 7.3.6.a 10.0.0 10/7/2014 BC-30-5B-EA-17-BA New 5/2012 FA-Proc8

FA P1 Process 9 8.1.7 4.0.9 5.1.1 14.6 (4790) 11 6.2 SP2 7.3.5a 10.0.0 10/7/2014 BC-30-5B-E9-FF-07 New 5/2012 FA-Proc9

FA CST 8.1.7 4.0.9 5.1.1 14.6 (4790) 11 6.2 SP2 7.3.6.a 10.0.0 13.0.0.6 10/7/2014 00-24-E8-3C-49-14 New Machine 3/2010, Formerly Proc_2 5/2012 FA-CST

FA FOO 8.1.7 4.0.9 5.2 14.6 (4790) 11 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 00-24-E8-3E-BF-FD New Machine 3/2010, Formerly Proc_3 5/2012 FA-FOO

FA CO 3.2.2.4 5.1.1.1 12.3  (r3834) 11 00-23-AE-68-4D-37

FA P2 Process1 8.1.7 4.0.0.5 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 00-1D-09-30-OB-38 Formerly FOO 5/2012 Fa-P2-P1

FA P3 Process1 8.1.7 4.0.0.5 5.2 14.6 (4790) 10.5 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 B8:AC:6F:89:DE:4C New Machine 3/2010 Fa-P3-P1

FA P3 Process2 8.1.7 4.0.9 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 B8:AC:6F:8D:0D:CE New Machine 3/2010, Formerly Proc_6 5/2012 Fa-P3-P2

FA P3 Process3 8.1.7 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.6.a 10.0.0 10/7/2014 00:24:E8:3C:8A:30 New Machine 3/2010, Formerly Pro_8 5/2012 Fa-P3-P3

FA P3 Process4 8.1.7 4.0.9 5.2 14.6 (4790) 6.2 SP2 7.3.5a 10.0.0 10/7/2014 B8:AC:6F:89:E0:B4 New Machine 3/2010 Fa-P3-P4

FA O-LAB 8.1.7 4.0.9 5.2 14.6 (4790) 6.2 SP2 10.0.0 10/7/2014 00:24:E8:3C:49:08 Formerly CST 5/2012 FA-OLAB

S220 Acq 12.1  (r3715) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-1D-09-31-BA-34

S220 Acq 2 12.2  (r3724) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 8/8/2011 00-24-E8-3E-BF-24 New Machine 3/2010, Formerly Proc_1 5/2012

2805 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 10/7/2014 00:13:3B:0E:5F:4B

2806 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 5.1.0.1 10/7/2014 00-13-3B-0D-F5-69

2807 Acq 3.1.1.1 13.8  (r4311) 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 5.1.0.1 10/7/2014 00:13:3B:0D:ED:1E To HI  on 7/1/11

2808 Acq 3.1.1.1 13.8  (r4311) 5.4 SP2 10.0.0 13.0.0.6 11.0.6.0 11.0.6.0 5.1.0.1 10/7/2014 00-13-3B-0D-ED-02

Mobile Station 8.1.7 3.1.1.0 4.0.9 5.2 13.8  (4512) 11 2.7 10.0.0 2010 10/7/2014 00-24-E8-B5-85-1D

Toughbook 2 3.1.1.0 12.9  (r4195) 10/7/2014 00-0B-97-27-72-92 Tides, Old

Toughbook 3 3.1.1.1 12.9  (r4195) 2.6 2009 10/7/2014 00-0B-97-33-1C-CD Some GPS Utilities, Old

Toughbook 4 3.1.1.1 12.2  (r3724) 2.7 2009 2/25/2011 00-21-5C-6C-2B-A3 Bluetooth

Toughbook 5 3.1.1.1 12.9  (r4195) 10/7/2014 00-1B-D3-38-1B-02 Tides

Toughbook 6 3.1.1.1 12.2  (r3724) 2.7 10.0.0 00-1B-D3-19-EA-4B Bluetooth
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Field Unit: FAIRWEATHER

Effective Date: March 20, 2014

Updated Through: July 27, 2014

Vessel Name FAIRWEATHER Launch 2805 Launch 2806 Launch 2807 Launch 2808

Hull Number S 220 2805 2806 2807 2808

Call Letters WTEB

Manufacturer Aerojet-General Shipyards All American Marine All American Marine All American Marine All American Marine

Year of Construction 1967 2009 2009 2009 2009

Type of Construction
Welded steel hull -
 ice strengthened

Welded Aluminum Welded Aluminum Welded Aluminum Welded Aluminum 

Length Overall 70.4 m (231') 8.64 m (28' 6") 8.64 m (28' 6") 8.64 m (28' 6") 8.64 m (28' 6")

Beam 12.8 m (42') 3.48 m (11' 5") 3.48 m (11' 5") 3.48 m (11' 5") 3.48 m (11' 5")

Draft 4.7 m (15' 6") 1.12 m (3' 8") 1.12 m (3' 8") 1.12 m (3' 8") 1.12 m (3' 8")

Cruising Speed 12.5 knots 24 knots 24 knots 24 knots 20 knots

Max Survey Speed 8 knots 8 knots 8 knots 8 knots 8 knots

Date of Effective Full Vessel 
Static Offset Survey

Origninal Survey 9/23/2003      
POS/MV Offsets Surveyed 2/2007 

and 2/15/2009
1/26/2010 1/26/2010 1/27/2010 1/27/2010

Organization which Conducted 
the Effective Full Offset Survey

Original Survey -  Westlake 
Consultants                   

POS/MV Spatial Surveys - NGS
NGS/GSD NGS/GSD NGS/GSD NGS/GSD

Date of Last Partial Survey or 
Offset Verification & Methods 
Used

n/a n/a n/a n/a n/a

Date of Last Static Draft 
Determination & Method Used

3/19/2014
Direct Measurement from 

benchmarks.

3/20/2014
Direct Measurement from 

benchmarks.

3/20/2014
Direct Measurement from 

benchmarks.

3/20/2014
Direct Measurement from 

benchmarks.

Date of Last Settlement and 
Squat/Dynamic Draft 
Measurements & Method Used

3/12/2014
Post Processed Kinematic 
(Ellipsoidally referenced)

3/04/2014
Post Processed Kinematic 
(Ellipsoidally referenced)

3/13/2014
Post Processed Kinematic 
(Ellipsoidally referenced)

3/05/2014
Post Processed Kinematic 
(Ellipsoidally referenced)

Hydrographic Vessel Inventory

SURVEY VESSELS



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number SBE 19Plus

Date of Report: 1/20/2014

Serial Number: 19P36026-4585

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/18/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: 0.0000 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4585

CALIBRATION DATE: 18-Jan-14

SBE19plus CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -1.029993e+000

h =  1.489894e-001

i = -1.549291e-004

j =  3.406971e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2630.81     0.0000      0.00000

   1.0000    34.6953    2.96661    5177.34     2.9666      0.00001

   4.5000    34.6678    3.27209    5370.86     3.2721     -0.00001

  15.0000    34.6263    4.25076    5947.93     4.2508     -0.00000

  18.5000    34.6178    4.59487    6137.68     4.5949     -0.00001

  24.0000    34.6083    5.15109    6432.32     5.1511      0.00001

  29.0000    34.6033    5.67134    6695.87     5.6713      0.00000

  32.5000    34.6005    6.04260    6877.60     6.0426     -0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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18-Jan-14 1.0000000



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4585

CALIBRATION DATE: 16-Jan-14

SBE19plus PRESSURE CALIBRATION DATA

 5076 psia S/N 5433

 

COEFFICIENTS:

PA0 =    5.948635e-001

PA1 =    1.546191e-002

PA2 =   -6.623496e-010

PTEMPA0 = -6.576957e+001

PTEMPA1 =  5.127049e+001

PTEMPA2 = -2.273131e-001

PTCA0 =  5.088111e+005

PTCA1 = -6.977354e-001

PTCA2 =  1.022961e-001

PTCB0 =  2.398063e+001

PTCB1 = -2.075000e-003

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.81 509762.7   1.7       14.79  -0.00         32.50     1.93   509809.00

 1026.87 575258.5   1.7     1026.51  -0.01         29.00     1.86   509784.72

 2038.84 641140.3   1.7     2038.43  -0.01         24.00     1.76   509761.81

 3050.91 707427.5   1.7     3050.77  -0.00         18.50     1.66   509743.84

 4063.06 774096.9   1.7     4063.08   0.00         15.00     1.59   509735.63

 5075.18 841130.1   1.7     5074.95  -0.00          4.50     1.38   509720.55

 4063.71 774160.7   1.7     4064.04   0.01          1.00     1.31   509720.01

 3051.23 707476.1   1.7     3051.52   0.01

 2038.89 641179.8   1.7     2039.05   0.00         TEMP(ITS90)   SPAN(mV)

 1026.80 575285.9   1.7     1026.93   0.00            -5.00       23.99

   14.81 509778.1   1.7       15.02   0.00            35.00       23.91

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number SBE 19Plus

Date of Report: 1/20/2014

Serial Number: 19P36026-4585

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/18/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00045 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4585

CALIBRATION DATE: 18-Jan-14

SBE19plus TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.152098e-003

a1 =  2.773419e-004

a2 = -1.294447e-006

a3 =  1.949972e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            686692.322             1.0001              0.0001

   4.5000            614014.322             4.4998             -0.0002

  15.0000            430469.814            15.0002              0.0002

  18.5000            380375.102            18.5000             -0.0000

  24.0000            311761.729            24.0000             -0.0000

  29.0000            259043.966            28.9998             -0.0002

  32.5000            226979.831            32.5001              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number SBE 19Plus

Date of Report: 1/16/2014

Serial Number: 19P36026-4617

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/16/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 16-Jan-14

SBE19plus CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.984795e-001

h =  1.276297e-001

i = -2.288706e-004

j =  3.271867e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2801.23     0.0000      0.00000

   1.0000    34.7372    2.96985    5581.73     2.9699      0.00001

   4.5000    34.7182    3.27638    5792.62     3.2764     -0.00001

  15.0000    34.6763    4.25625    6419.68     4.2562     -0.00001

  18.5000    34.6675    4.60075    6625.76     4.6008      0.00000

  24.0000    34.6581    5.15769    6945.65     5.1577      0.00001

  29.0000    34.6533    5.67862    7231.70     5.6786      0.00001

  32.5000    34.6506    6.05036    7428.87     6.0503     -0.00001

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 14-Jan-14

SBE19plus PRESSURE CALIBRATION DATA

 1450 psia S/N 5513

 

COEFFICIENTS:

PA0 =   -4.418185e-001

PA1 =    4.448806e-003

PA2 =   -1.451681e-011

PTEMPA0 = -7.843733e+001

PTEMPA1 =  4.852587e+001

PTEMPA2 = -2.463212e-001

PTCA0 =  5.192626e+005

PTCA1 = -9.837469e+000

PTCA2 =  2.408337e-001

PTCB0 =  2.460838e+001

PTCB1 =  6.750000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.91 522625.3   2.1       14.95   0.00         32.50     2.31   522692.22

  301.88 587147.6   2.1      301.74  -0.01         29.00     2.24   522686.93

  588.62 651714.2   2.1      588.62   0.00         24.00     2.13   522677.90

  875.57 716321.7   2.1      875.55  -0.00         18.50     2.02   522667.79

 1162.48 780959.7   2.1     1162.50   0.00         15.00     1.95   522664.07

 1449.34 845584.5   2.1     1449.27  -0.00          4.50     1.72   522716.11

 1162.69 781022.1   2.1     1162.77   0.01          1.00     1.65   522764.68

  875.67 716363.4   2.1      875.73   0.00

  588.45 651667.4   2.1      588.41  -0.00         TEMP(ITS90)   SPAN(mV)

  301.63 587126.6   2.1      301.65   0.00            -5.00       24.61

   14.90 522625.2   2.1       14.95   0.00            35.00       24.63

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number SBE 19Plus

Date of Report: 1/16/2014

Serial Number: 19P36026-4617

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/16/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00025 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4617

CALIBRATION DATE: 16-Jan-14

SBE19plus TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.270565e-003

a1 =  2.607622e-004

a2 =  4.136364e-007

a3 =  1.360207e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            585600.814             1.0000              0.0000

   4.5000            518770.932             4.5000             -0.0000

  15.0000            354141.034            14.9999             -0.0001

  18.5000            310214.492            18.5001              0.0001

  24.0000            250755.915            24.0001              0.0001

  29.0000            205623.983            28.9998             -0.0002

  32.5000            178407.475            32.5001              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)

-0.02

-0.01

0.00

0.01

0.02

-5 0 5 10 15 20 25 30 35

R
e

s
id

u
a

l,
 (

D
e

g
re

e
s
 C

)

Temperature, Degrees C

15-Jan-13  -0.25

16-Jan-14   0.00



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number SBE 19Plus

Date of Report: 1/20/2014

Serial Number: 19P50959-6121

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/18/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 18-Jan-14

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -1.001418e+000

h =  1.548914e-001

i = -3.907295e-004

j =  5.187225e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2548.12     0.0000      0.00000

   1.0000    34.6953    2.96661    5072.05     2.9666     -0.00001

   4.5000    34.6678    3.27209    5263.23     3.2721      0.00001

  15.0000    34.6263    4.25076    5832.93     4.2508      0.00000

  18.5000    34.6178    4.59487    6020.18     4.5949     -0.00001

  24.0000    34.6083    5.15109    6310.86     5.1511      0.00001

  29.0000    34.6033    5.67134    6570.77     5.6713     -0.00001

  32.5000    34.6005    6.04260    6749.95     6.0426      0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 17-Jan-14

SBE19plusV2 PRESSURE CALIBRATION DATA

  870 psia S/N 2752079

 

COEFFICIENTS:

PA0 =   -2.350291e-001

PA1 =    2.640154e-003

PA2 =    1.729797e-011

PTEMPA0 = -5.960280e+001

PTEMPA1 =  5.313681e+001

PTEMPA2 = -2.904244e-001

PTCA0 =  5.247711e+005

PTCA1 = -5.720413e+000

PTCA2 =  6.212014e-002

PTCB0 =  2.511463e+001

PTCB1 = -1.075000e-003

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.75 530349.0   1.5       14.75   0.00         32.50     1.75   530423.53

  180.02 592850.0   1.5      180.00  -0.00         29.00     1.68   530433.47

  360.02 660872.0   1.5      360.00  -0.00         24.00     1.59   530445.94

  540.04 728852.0   1.5      540.05   0.00         18.50     1.48   530460.31

  720.05 796752.0   1.5      720.04  -0.00         15.00     1.42   530473.54

  870.05 853287.0   1.5      870.03  -0.00          4.50     1.21   530518.66

  720.08 796772.0   1.5      720.10   0.00          1.00     1.15   530542.04

  540.08 728870.0   1.5      540.10   0.00

  360.06 660900.0   1.5      360.08   0.00         TEMP(ITS90)   SPAN(mV)

  180.06 592868.0   1.5      180.05  -0.00            -5.00       25.12

   14.75 530350.0   1.5       14.76   0.00            35.00       25.08

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number SBE 19Plus

Date of Report: 1/20/2014

Serial Number: 19P50959-6121

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/18/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00039 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6121

CALIBRATION DATE: 18-Jan-14

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.288252e-003

a1 =  2.570040e-004

a2 =  9.626867e-008

a3 =  1.347581e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            648463.289             1.0001              0.0001

   4.5000            575540.022             4.4999             -0.0001

  15.0000            394113.067            15.0000              0.0000

  18.5000            345376.778            18.5002              0.0002

  24.0000            279275.044            23.9998             -0.0002

  29.0000            229041.156            28.9999             -0.0001

  32.5000            198754.778            32.5001              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number: SBE 19Plus

Date of Report: 1/24/2014

Serial Number: 19P50959-6122

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/23/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 23-Jan-14

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.955229e-001

h =  1.572791e-001

i = -5.334606e-004

j =  6.640190e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2523.30     0.0000      0.00000

   1.0000    34.7015    2.96709    5035.52     2.9671      0.00000

   4.4999    34.6821    3.27330    5226.01     3.2733     -0.00000

  14.9999    34.6399    4.25225    5792.34     4.2522     -0.00000

  18.5000    34.6310    4.59643    5978.42     4.5964     -0.00000

  24.0000    34.6212    5.15280    6267.21     5.1528      0.00000

  28.9999    34.6160    5.67318    6525.40     5.6732      0.00001

  32.4999    34.6128    6.04449    6703.32     6.0445     -0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 22-Jan-14

SBE19plusV2 PRESSURE CALIBRATION DATA

  870 psia S/N 2752080

 

COEFFICIENTS:

PA0 =   -1.620726e-001

PA1 =    2.636229e-003

PA2 =    1.997796e-011

PTEMPA0 = -6.152100e+001

PTEMPA1 =  5.373990e+001

PTEMPA2 = -2.614733e-001

PTCA0 =  5.243965e+005

PTCA1 = -1.810057e+000

PTCA2 = -5.603788e-002

PTCB0 =  2.507825e+001

PTCB1 = -5.500000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.79 530006.0   1.6       14.80   0.00         32.50     1.76   530071.00

  180.07 592626.0   1.6      180.05  -0.00         29.00     1.70   530090.35

  360.08 660774.0   1.6      360.07  -0.00         24.00     1.60   530115.09

  540.09 728850.0   1.6      540.08  -0.00         18.50     1.50   530137.16

  720.10 796856.0   1.6      720.09  -0.00         15.00     1.43   530150.61

  870.09 853462.0   1.6      870.07  -0.00          4.50     1.24   530176.73

  720.12 796876.0   1.6      720.15   0.00          1.00     1.17   530190.64

  540.12 728870.0   1.6      540.14   0.00

  360.11 660794.0   1.6      360.12   0.00         TEMP(ITS90)   SPAN(mV)

  180.10 592642.0   1.6      180.10  -0.00            -5.00       25.08

   14.79 530002.0   1.6       14.79   0.00            35.00       25.06

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number: SBE 19Plus

Date of Report: 1/24/2014

Serial Number: 19P50959-6122

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/23/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00038 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6122

CALIBRATION DATE: 23-Jan-14

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.312097e-003

a1 =  2.509387e-004

a2 =  8.058508e-007

a3 =  1.047052e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            640400.186             1.0001              0.0001

   4.4999            567825.746             4.4998             -0.0001

  14.9999            387709.373            14.9999              0.0000

  18.5000            339437.424            18.5001              0.0001

  24.0000            274046.780            23.9998             -0.0002

  28.9999            224418.746            28.9999              0.0000

  32.4999            194527.593            32.4999              0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number SBE 19Plus

Date of Report: 1/20/2014

Serial Number: 19P75459-7370

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/18/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 7370

CALIBRATION DATE: 18-Jan-14

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.858586e-001

h =  1.406313e-001

i = -2.106986e-004

j =  3.542145e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2650.61     0.0000      0.00000

   1.0000    34.6953    2.96661    5303.72     2.9666     -0.00000

   4.5000    34.6678    3.27209    5504.22     3.2721      0.00000

  15.0000    34.6263    4.25076    6101.58     4.2508      0.00001

  18.5000    34.6178    4.59487    6297.88     4.5949     -0.00001

  24.0000    34.6083    5.15109    6602.58     5.1511      0.00000

  29.0000    34.6033    5.67134    6875.02     5.6713     -0.00000

  32.5000    34.6005    6.04260    7062.83     6.0426      0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 7370

CALIBRATION DATE: 17-Jan-14

SBE19plusV2 PRESSURE CALIBRATION DATA

  870 psia S/N 3874647

 

COEFFICIENTS:

PA0 =    2.037083e+000

PA1 =    2.646943e-003

PA2 =    2.276102e-011

PTEMPA0 = -6.408118e+001

PTEMPA1 =  5.235941e+001

PTEMPA2 = -2.255215e-001

PTCA0 =  5.244342e+005

PTCA1 =  4.818701e+001

PTCA2 = -5.795030e-001

PTCB0 =  2.507550e+001

PTCB1 = -3.000000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.75 530000.0   1.6       14.74  -0.00         32.50     1.86   530348.42

  180.02 592350.0   1.6      179.91  -0.01         29.00     1.79   530306.12

  360.02 660229.0   1.6      359.94  -0.01         24.00     1.70   530218.60

  540.04 728042.0   1.6      540.01  -0.00         18.50     1.59   530091.72

  720.05 795759.0   1.7      720.02  -0.00         15.00     1.52   529986.83

  870.05 852125.0   1.7      870.03  -0.00          4.50     1.32   529595.08

  720.08 795797.0   1.7      720.13   0.01          1.00     1.25   529447.39

  540.08 728092.0   1.7      540.14   0.01

  360.06 660304.0   1.7      360.14   0.01         TEMP(ITS90)   SPAN(mV)

  180.06 592431.0   1.7      180.12   0.01            -5.00       25.08

   14.75 530026.0   1.7       14.79   0.00            35.00       25.07

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Customer: Pacific Marine Center / NOAA

Job Number: 77107

Model Number SBE 19Plus

Date of Report: 1/20/2014

Serial Number: 19P75459-7370

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/18/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00033 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 7370

CALIBRATION DATE: 18-Jan-14

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.278550e-003

a1 =  2.688270e-004

a2 = -6.836589e-007

a3 =  1.655495e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            563405.847             1.0000              0.0000

   4.5000            497148.593             4.5000             -0.0000

  15.0000            335312.492            15.0001              0.0001

  18.5000            292513.644            18.4999             -0.0001

  24.0000            234865.763            24.0000             -0.0000

  29.0000            191349.559            29.0001              0.0001

  32.5000            165224.847            32.5000             -0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Appendix II 
 
 
Vessel Reports, Offsets, and Diagrams 
 
Launch 2805 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 
5. Waterline Measurements 

 
Launch 2806 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 
5. Waterline Measurements 

 
Launch 2807 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 
5. Waterline Measurements 

 
Launch 2808 

1. Offsets 
2. Patch Test 
3. POS MV GAMS Calibration 
4. Dynamic Draft 
5. Waterline Measurements 

 
 
Wiring Diagrams 
 
Coordinate Systems Utilized in Vessel Offsets 
 
Reference Surface Comparison  
 
Dynamic Draft Comparison 
 
Multibeam to Leadline Sounding Comparison 



2805 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.004 0.686 n/a Scaler Distance 1.447 -0.682 -0.806 0.000 0.000
y 0.000 0.245 1.051 n/a -0.806 -0.682 0.000 0.000
z 0.000 0.482 3.656 -0.098 -3.174 -3.174 0.000 0.000

*IMU is Reference Point -0.111

Vessel Offsets for 2805 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2014 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.68217 RP to Waterline (m) IMU to x -0.68217 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.80598 z 0.098 Port Ant (m) y -0.80598 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.17407 (calculated) z 3.17407 z 0.00000 z 0.00000

MBES RP x 0.00401 IMU to 7125 x 0.00401 IMU (m) x, y, z 0.00000 Top of x -0.68217 Heave Pt (m)   x 0.00000
Rcvr - Phase (m)      y 0.24503 Phase Ctr y 0.24503 2010 RP to Waterline (m) Port Ant (m)  y -0.80598 (by design) y 0.00000
Center z -0.48191 (calculated) z -0.48191 z 0.111 Top of x 0.76454 z 3.16277 z 0.00000

Stbd Ant (m)  y -0.80778
z 3.14528 Base to top of Port Ant

(measured) (m)  z 0.073
                               Base to top of Stbd Ant

(measured) (m)  z 0.073 Bottom of Port Ant
(calculated) (m)  z 3.08977

Bottom of Stbd Ant
(calculated) (m)  z 3.07228 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to 7125 x 0.00401 x 0.68618 x n/a x -0.68217 x 0.00000

Phase Ctr y 0.24503 y 1.05101 y n/a Scalar Distance 1.4468 y -0.80598 y 0.00000
z -0.48191 z -3.65598 z 0.098 z 3.17407 z 0.00000

Coord. Sys. x 0.00401 Coord. Sys. x 0.68618 Coord. Sys. x n/a Coord. Sys. x ‐0.80598 Coord. Sys. x 0.00000
CARIS y 0.24503 CARIS y 1.05101 CARIS y n/a Pos/Mv y ‐0.68217 Pos/Mv y 0.00000

z 0.48191 z 3.65598 z ‐0.098 z ‐3.17407 z 0.00000

IMU to 7125 Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(2010 used for K5K)

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)



  

x y z x y z x y z x y z x y z
0.004 0.245 0.482 0.686 1.051 3.656 N/A N/A -0.098 -0.682 -0.806 -3.174 0.000 0.000 0.000

x y z x y z
0.534 0.845 0.772 0.609 -5.525 -2.186

Description of Offsets for Launch 2805

All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2805 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  
These locations were used to calculate offsets of items with respect to each other, as described for each offset.

IMU to 7125 Port Ant to 7125

The offsets were determined 
using the NGS 2009 survey 
values for the A-Frame Stbd 
Pivot and measurements by 
FA personnel. 
Measurements between the 
A-Frame Pivot and the Tow 
point were made with a steel 
tape and digital level to 

IMU to K5K

RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

IMU to Tow PT K5K

IMU to Heave
Scalar Distance

1.447

The physical positions of the 
IMU and the receiver phase 
center of the 7125 were 
measured during the NGS 
survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

The values were calculated by 
subtracting the physical height 
of the Port Antenna to the IMU x, 
y, z values from the respective 
values of the IMU to the 7125.  
The calculated values were then 
transposed from the NGS to the 
CARIS coordinate system.

The average vertical distance 
from Port Benchmark to 
waterline and the Starboard
Benchmark to the waterline were 
measured by FAIRWEATHER 
personnel using a steel tape and 
bubble level.  These values were 
combined with the Z value of the 
Benchmarks to the RP/IMU to get 
an average for the waterline to 
RP.  The Waterline Measurement 
value is in NGS coordinates 
initially and is converted to CARIS 
coordinates.

The location of the IMU and the 
location of the top of port 
antenna were surveyed by NGS.  
The z‐value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base 
of the antenna to the phase 
center of the antenna. The 
calculation results were then 
transposed from the NGS to the 
CARIS coordinate system. 

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

1.447 m

-3.174 m

3.656 m

0.482 m

0.004 m

7125 Phase 
Center

IMU 
Reference 
Pt.

Primary Antenna Reference Pt.

2805
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.686 m 
Port Ant. to 7125 

0.004 m

IMU Reference Pt.

1.447 m

0.245 m

7125 Phase Center

1.051 m

-0.806 m
Primary Antenna Reference Pt.

2805
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.686 m
Port Ant. to 7125 

-0.682 m

The location of the IMU and the 
location of the forward keel  
benchmark were surveyed by 
NGS.  BM to K5K were measured 
by FAIRWEATHER personnel 
using a steel tape and bubble 
level.

0.845 m

0.534 m

K5K Reference Pt.

0.772 m

0.534 m 
K5K Reference Pt.
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NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2805.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 26th of 
January, 2010.  The weather was sunny early then cloudy with  temperatures in the 40s to 
50s.  For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.000m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU.  
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 

 



NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 



 
 

NOAA SURVEY VESSEL 2805 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 
STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMC-  CENTERLINE CAB BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the cab, along the centerline of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 



 
 
 

Appendix A 
 

Coordinate Report Launch 2805 
 
Pt Name      North(Y) East(X) Elev.(Z) ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13270    -0.00348    -0.16937    IMUR  
Centerline Stern BM          -4.04803     0.01735     0.67574     CLS   
Centerline Bow BM    3.46914     0.01735     1.39751     BMB   
Portside GPS Ant. Ref. Point -0.80598    -0.68217     3.16277     GPSP  
Starboard GPS Ant. Ref. Point-0.80778     0.76454     3.14528     GPSS  
Multi-Beam Ref.Point    0.24503     0.00401    -0.48191    MB    
Keel BM      0.44007    -0.00202    -0.61410    MBF   
Keel BM        -0.22895    -0.00227    -0.53363    MBA   
Port Side BM     0.10603    -1.42637     1.07535     BMP   
Starboard Side BM     0.10926     1.45859     1.04250     BMS   
Centerline Cab BM       -0.19024     0.03192     2.65903     BMC 
 
Units = meters 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

Appendix B  
 

Point to Point Inverse Launch 2805 
 

Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
18        31      0.004     -0.003     0.003    -0.00141  BMC  
 9        29      0.001     0.001    - 0.001     0.00051  BMP  
39        49      0.003    -0.003     0.001    -0.00063  BMS  
 8        48      0.001    -0.001    -0.001     0.00016  CLS  
10        30      0.002    -0.001     0.002     0.00033  GPSP  
11        41      0.000     0.000     0.000     0.00034  GPSS  
16        53      0.001     0.000     0.001     0.00024  IMU  
17        54      0.002     0.000    0.002     0.00029  IMUR  
 4        46      0.006     0.005     0.002    -0.00018  MB  
 5        47      0.001     0.000     0.001     0.00016  MBA  
 3        45      0.002     0.001     0.001    -0.00017  MBF 
 
Units = meters 
 
 
 
 
 

 



FAIRWEATHER

Multibeam Echosounder Calibration
Vessel

3/4/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/4/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

2148 9.38
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

2253 8.9
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2014_063_225323 44/37/35.87 124/02/25.00

Launch 2805 200kHz

Bravo,Bradley,Brooks

Bravo,Bradley

2805

063

7125

2014_063_2805.554-.566

03/03/2014

Newport,OR

sand

partly cloudyNewport,OR

7.5m

063

POSMV Filename(s)

Applanix POS/MV   S/N:XXXX    IMU S/N:XXX

44/37/31.07 124/02/12.8602014_063_214813



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 292 4.0
2 290 4.0
3 291 8.0
4 290 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 110 4.0
2 292 4.0
3
4
5 287 4.0
6 115 4.0
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 288 4.0
2 112 4.0
3 288 4.0
4 115 4.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 295 4.0
2 125 4.0
3 2014M_063_2242 293 4.0
4 2014M_063_2246 122 4.0
5 2014M_063_2249 299 4.0
6
7
8

XTF Line Filename

2014M_0632221
XTF Line Filename

2014M_0632224

2014M_0632230

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0632227

2014M_0632203
2014M_0632208
2014M_0632211

2014M_0632158

2014M_0632216
2014M_0632218

2014M_0632203

XTF Line Filename
2014M_0632212

2014M_063_2239
2014M_063_2235

XTF Line Filename



Processing Log

3/3/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

2203/2208 0.00 2216/2212 -1.44 2235/2239 -0.13 2230/2224 0.07
2158/2208 0.00 2203/2212 -1.32 2246/2249 -0.11 2230/2224 0.00
2158/2208 0.00 2203/2212 -1.47 2246/2242 -0.08 2227/2230 0.08

0.00 -1.41 -0.11 0.05
0.00 0.08 0.03 0.04
0.00 -1.41 -0.11 0.05

MRU Align StdDev gyro 0.04 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.05 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014

Data converted --> HDCS_Data in CARIS

063

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

GDC

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

9435380.tid

Compute correctors in this order

Ryan Wratick

GDC

GDC

GDC

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Argento



FAIRWEATHER

Multibeam Echosounder Calibration
Vessel

3/4/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/4/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

7.13
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1810 7.63
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2014 44/37/29.72 124/02/25.07

Launch 2805 400kHz

Bravo, Bradley

Bradley, Bravo

2805

063

7125

sonar crashed at 1753

2014_031_2805.537

03/03/2014

Newport,OR

sand

Partly cloudyNewport,OR

7.5m

063

POSMV Filename(s)

Applanix POS/MV   S/N:2411    IMU S/N:XXX

44/37/33.88N 124/02/18.652014_063_164421.HEX



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 289 4.0
2 289 4.0
3 288 8.0
4 289 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 109 4.0
2 290 4.0
3
4
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 109 4.0
2 290 4.0
3 110 4.0
4 291 4.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 113 4.0
2 309 4.0
3 2014M_0631759.HSX 303 4.0
4 2014M_0631803.HSX 123 4.0
5
6
7
8

XTF Line Filename

2014M_0631731
XTF Line Filename

2014M_0631734

2014M_0631740

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0631737

2014M_0631708
2014M_0631714
2014M_0631718

2014M_0631703

2014M_0631723.PITCH

XTF Line Filename
2014M_0631711_PITCH

2014M_0631750_Roll.HSX
2014M_0631746_Roll.HSX

XTF Line Filename



Processing Log

3/4/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1708/1714 0.00 1711/1723 -1.40 1746/1750 -0.13 1737/1740 -0.12
1708/1714 0.00 1711/1723 -1.50 1759/1803 -0.16 1731/1734 0.00
1708/1714 0.00 1711/1723 -1.28 1759/1803 -0.10 1731/1734 0.00

0.00 -1.39 -0.13 -0.04
0.00 0.11 0.03 0.07
0.00 -1.39 -0.13 -0.04

MRU Align StdDev gyro 0.07 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.07 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014

9435380.tid

Data converted --> HDCS_Data in CARIS

063

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

GDC

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Ryan Wartick

GDC

GDC

GDC

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Argento



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: NOAA Ship Fairweather Vessel: 2805

Date: 3/3/2014 Dn: 62

Personnel: SS Brooks, ENS Chensue, ENS Friel

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About)

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

1010

NOAA POS/MV Calibration Report

2411

129.100.1.231

Calibration area
Location:

Approximate Position: Lat

Lon

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 287

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

Yaquina Bay

Secondary GPS

N

Fort Stevens

POSMV filename(s)



PDOP 1.89 (Use View> GAMS Solution)



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 950

End time: 958

Heading accuracy achieved for calibration: 0.3

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2



COM3

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting

User Parameter Accuracy (Use Settings > Installation > User Accuracy)User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



2014 Fairweather HSRR: Launch 2805, DN 64 

3rd Order Ellipsoidally Referenced Dynamic Draft Measurement (ERDDM) 

 

 



 



Launch 2805 ERDDM (Delta Draft, M)

Historical 
Average

0 0.0014 0.0106 0.0218 0.035 0.0442 0.0508 0.0508 0.0396 0.0178 ‐0.0186 ‐0.0722 ‐0.144 ‐0.1895 ‐0.26575 ‐0.176 ‐0.176

Speed (m/s) 0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5 5.5 6 6.5 7 7.5 8 8.5 9 9.5 10 NOTES
Seattle, 2010 Seattle, WA
Seattle,2011 0 0 0 0.01 0.02 0.03 0.04 0.04 0.04 0.02 ‐0.03 ‐0.11 ‐0.23 Seattle, WA

Newport, 2012 0 0.01 0.02 0.03 0.05 0.05 0.05 0.05 0.02 ‐0.01 ‐0.07 ‐0.14 ‐0.24 ‐0.36 ‐0.51 Newport, OR
Seattle,2013 0 ‐0.01 0.01 0.03 0.05 0.07 0.08 0.08 0.06 0.03 ‐0.01 ‐0.07 ‐0.13 ‐0.19 ‐0.24 ‐0.27 ‐0.27 Seattle, WA

Newport,2014 0 0.01 0.02 0.03 0.04 0.05 0.06 0.06 0.06 0.04 0.02 ‐0.02 ‐0.08 ‐0.15 ‐0.24 Newport, OR
Bad entry 2013 0 ‐0.003 0.003 0.009 0.015 0.021 0.024 0.024 0.018 0.009 ‐0.003 ‐0.021 ‐0.04 ‐0.058 ‐0.073 ‐0.082 ‐0.082

‐0.5

‐0.4

‐0.3

‐0.2

‐0.1

0

0.1

0.2

0 1 2 3 4 5 6 7 8 9
Seattle, 2010

Seattle,2011

Newport, 2012

Seattle,2013

Newport,2014

Historical Average

Bad entry 2013

‐0.6

‐0.5



Measuring Party:

Waterline measurements should be negative and cm!

Date: 3/7/2014
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 0.0290 -0.0039

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.105

Individual 0.10535 0.09450
measurement 0.11235 0.10450
StDev for TPU xls 0.006 0.10335 0.11050
(of 6 #'s)

Measuring Party:

Date: 3/19/2014
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference -95                    

Avg (cm) Theoretical Actual Error

Avg (m) 0.0329 0.0500 0.0172

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.091

(Add this value to VSSL_Offsets & Measurements_20XX.xls)

Individual 0.06435 0.11150
measurement 0.08935 0.09850
StDev for TPU xls 0.015 0.09335 0.08850 Averaged values utilized in Offsets and Measurements and TPU spreadsheet

(of 6 #'s)

Fill in Yellow squares only!

2805

Ramsay, Bradley, Argento

1.07535

Waterline Measurements

-93.200

2805
Port Benchmark to Waterline Stbd Benchmark to Waterline 106 gal

69 gal

-97.000 -94.800

-0.9393

-97.200

-0.9930

-98.200

0.107

-95.400

-101.100

2805

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.103

-96.300

0.00473 0.00808

0.08235 0.100

Waterline measurements should be negative and cm!

0.01572 0.01153

1.07535 1.04250

-93.100

-0.9430

-98.600

-99.30 -94.30

-94.400

-0.9683

1.04250

-93.800

-93.93

Bravo, Bradley, Berube, Nalley

-96.83



2806 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 -0.013 0.624 n/a Scaler Distance 1.448 -0.637 -0.832 0.000 0.000
y 0.000 0.254 1.087 n/a -0.832 -0.637 0.000 0.000
z 0.000 0.481 3.603 -0.097 -3.122 -3.122 0.000 0.000

*IMU is Reference Point

Vessel Offsets for 2808 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2014 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.63695 RP to Waterline (m) IMU to x -0.63695 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.83249 z 0.097 Port Ant (m) y -0.83249 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.12238 (calculated) z 3.12238 z 0.00000 z 0.00000

MBES RP x -0.01284 IMU to x -0.01284 IMU (m) x, y, z 0.00000 Top of x -0.63695 Heave Pt m)   x 0.00000
Rcvr - Phase (m)      y 0.25447 Phase Ctr y 0.25447 Port Ant (m)  y -0.83249 (by design) y 0.00000
Center z -0.48083 (calculated) z -0.48083 Top of x 0.81062 z 3.14938 z 0.00000

Stbd Ant (m)  y -0.82526
z 3.10821 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.07638
Bottom of Stbd Ant
(calculated) (m)  z 3.03521 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.046
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.046

Coord. Sys.
NGS IMU to x -0.01284 x 0.62411 x n/a x -0.63695 x 0.00000

Phase Ctr y 0.25447 y 1.08696 y n/a Scalar Distance 1.4482 y -0.83249 y 0.00000
z -0.48083 z -3.60321 z 0.097 z 3.12238 z 0.00000

Coord. Sys. x -0.01284 Coord. Sys. x 0.62411 Coord. Sys. x n/a Coord. Sys. x -0.83249 Coord. Sys. x 0.00000
CARIS y 0.25447 CARIS y 1.08696 CARIS y n/a Pos/Mv y -0.63695 Pos/Mv y 0.00000

z 0.48083 z 3.60321 z -0.097 z -3.12238 z 0.00000

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 (Receiver) Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave



Description of Offsets for Launch 2806

All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2806 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

1.448 m Primary Antenna Reference Pt.
7125 Phase Center

3.136 m

3.617 m

1 448 m

0.254 m

1.087 m

0.832m
Primary Antenna Reference Pt.

0.624 m
7125 to Port Ant.

IMU Reference Pt.

0.0128 m

IMU Reference Pt.

1.448 m

2806
LOA:    8.64m

0.481 m

0.013 m

7125 Phase Center

2806
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.624 m
7125 to Port Ant.

Beam:  3.48m
Draft:    1.12m

x y z x y z x y z x y z x y z
-0.013 0.254 0.481 0.624 1.087 3.603 n/a n/a -0.097 -0.637 -0.832 -3.122 0.000 0.000 0.000

RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave

Scalar Distance
1.448

IMU to 7125 Port Ant to 7125

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 

The values were calculated by 
subtracting the top of the Port
Antenna to the IMU x, y, z values 
then from the respective values of 
the IMU to the 7125.  The 
calculated values were then 
transposed from the NGS to the 

The average vertical distance 
from Port Benchmark to 
waterline and the Starboard
Benchmark to the waterline were 
measured by FAIRWEATHER 
personnel using a steel tape and 
b bbl l l h l

The location of the IMU and the 
location of the top of port 
antenna were surveyed by NGS.  
The z-value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base 
of the antenna to the phase

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 

7125 to Port Ant.

the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

the IMU to the 7125.  The 
calculated values were then 
transposed from the NGS to the 
CARIS coordinate system.

measured by FAIRWEATHER 
personnel using a steel tape and 
bubble level.  These values were 
combined with the Z value of the 
Benchmarks to the RP/IMU to 
get an average for the waterline 
to RP.  The Waterline 
Measurement value is in NGS 
coordinates initially and is 
converted to CARIS coordinates.

height of the antenna and then 
adding the value from the base 
of the antenna to the phase 
center of the antenna. The 
calculation results were then 
transposed from the NGS to the 
CARIS coordinate system. 

center. Then the scalar distance 
between the phase centers was 
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NOAA SURVEY VESSEL 2806 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2806.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 26th of 
January, 2010.  The weather was sunny then cloudy with  temperatures in the 40s to 50s.  
For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica  TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2806 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
   
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 



NOAA SURVEY VESSEL 2806 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.000m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU. The resulting coordinates are reported in 
appendix A. 
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr  p/n 39105-00) are to the top 
center of the antenna. To correct the Z value provided in this report for each antenna to 
the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 
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Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 



 
 

NOAA SURVEY VESSEL 2806 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 
STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMC-  CENTERLINE CAB BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the cab, along the centerline of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 



Appendix A 
 

Coordinate Report Launch 2806 
 
Pt Name      North(Y) East(X) UP(Z)  ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13142     -0.01122      -0.16986    IMUR  
Centerline Stern BM           -4.08215     0.02583    0.62671     CLS   
Centerline Bow BM    3.44035     0.02583    1.42590     BMB   
Portside GPS Ant. Ref. Point -0.83249     -0.63695   3.14938      GPSP  
Starboard GPS Ant. Ref. Point-0.82526   0.81062    3.10821       GPSS  
Multi-Beam Ref.Point    0.25447     -0.01284      -0.48083    MB    
Keel BM      0.44302     -0.02150      -0.61052    MBF   
Keel BM        -0.22767     -0.01641      -0.53926    MBA   
Port Side BM     0.08725     -1.41542   1.09615     BMP   
Starboard Side BM     0.09859    1.46945    1.01777       BMS   
Centerline Cab BM       -0.21255   0.06840    2.64944     BMC 
 
Units = meters 
 
 
 
      
      
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Appendix B  
 

Point to Point Inverse Launch 2806 
 

Pt. 1     Pt. 2   Dist.     Northing  Easting   Elevation  ID 
24        42      0.001    0.000    -0.001     0.00012    SBF  
 6        22      0.000    0.000      0.000     0.00025    SBA  
 7        23      0.001    0.001    -0.001     0.00048    SB  
33        35      0.004    0.003     0.001     0.00015    IMUR  
36        32      0.004    -0.002    -0.004     0.00010    IMU  
37        25      0.002    0.001      0.001     0.00013    CLS  
12        26      0.002    -0.001    -0.002     0.00054    BMS  
38        50      0.002    -0.002     0.000     0.00010    BMP  
52        20      0.006    0.006    -0.003     0.00045    BMB  
51        15      0.002    0.001     0.002     0.00011    BMC  
13        27      0.003    0.003    -0.001     0.00080    GPSS  
28        14      0.000    0.000     0.000     0.00023    GPSP 
 
Units = meters 
 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/5/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/5/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

2222 9.8
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

2318 9.6
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2014_064_222218.HEX

2014_064_231856 44/37/26.17N 124/02/18.6W

Launch 2806 200kHz

Marcus,Argento,Ferguson

Marcus,Argento

FA2806

064

RESON 200kHz

2014_064_2806.081-091

Yaquina Bay

sand, mud

OVC, RainYaquina Bay

9m

064

POSMV Filename(s)

Applanix POS/MV   S/N:2560    IMU S/N:XXX

44/37/35.5N 124/02/27.7W



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 286 4.3
2 284 4.1
3 290 8.1
4 290 8.1
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 106 5.4
2 292 4.3
3 108 5.3
4 288 4.3
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 110 5.3
2 110 5.2
3 110 4.6
4 110 4.8
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 295 4.6
2 123 4.3
3 298 4.8
4 120 4.1
5
6
7
8

XTF Line Filename
2014M_064_2305

2014M_0642250
XTF Line Filename

2014M_0642254

2014M_0642302

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0642258

2014M_0642231
2014M_0642235
2014M_0642238

2014M_0642227

2014M_0642245
2014M_0642248

2014M_0642242

XTF Line Filename
2014M_0642240

2014M_064_2308
2014M_064_2312
2014M_064_2315



Processing Log

3/5/2014
Date Dn Personnel

Zone file

Lines merged KG

Data cleaned to remove gross fliers KG

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

2227/2231 0.00 2240/2242 -1.60 2305/2315 -0.19 2254/2258 0.60
2231/2235 0.00 2245/2248 -1.45 2305/2308 -0.14 2250/2258 0.80
2231/2235 0.00 2242/2245 -1.52 2305/2308 -0.16 2254/2302 0.72

0.00 -1.52 -0.16 0.71
0.00 0.08 0.03 0.10
0.00 -1.52 -0.16 0.71

MRU Align StdDev gyro 0.10 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.05 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014

Data converted --> HDCS_Data in CARIS

064

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Golmon, Chensue, Ramsay

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Ryan Wartick

KG

KG

KG

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Argento
Wartick



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/5/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/5/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1637 6
SV Cast #1 filename UTC Time Lat Lon Ext. Depth

1747 7.7
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

Applanix POS/MV   S/N:2560    IMU S/N:XXX

44/37/35.5N 124/02/27.7W

Launch 2806 400kHz

Marcus,Argento,Ferguson

Marcus,Argento

2806

064

RESON 400kHz

Sync Errors ><14, Hysweep crash at 1719

2014_064_2806.067-079

Yaquina Bay,OR

Sand,Mud

OVC,RainYaquina Bay,OR

9m

064

POSMV Filename(s)

2014_064_163749.HEX

2014_064_174721.HEX 44/37/26.17N 124/02/18.59W



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 110 4.2
2 110 4.3
3 110 8.1
4 110 8.3
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 117 4.2
2 283 5.0
3 114 4.1
4 282 5.0
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 116 4.0
2 108 4.4
3 110 4.3
4 110 4.1
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 300 4.7
2 121 4.4
3 300 4.5
4 120 4.4
5
6
7
8

2014M_0641706
2014M_0641709

2014M_0641703

XTF Line Filename
2014M_0641701

2014M_0641737
2014M_0641740
2014M_0641743

2014M_0641647.HSX
XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0641725

2014M_0641651.HSX
2014M_0641655.HSX
2014M_0641657.HSX

2014M_0641712
XTF Line Filename

2014M_0641716

2014M_0641729

XTF Line Filename
2014M_0641733



Processing Log

3/5/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1651/1655 0.00 1706/1709 -2.20 1733/1737 -0.19 1712/1716 0.70
1647/1655 0.00 1701/1703 -2.30 1733/1737 -0.18 1725/1729 0.40
1647/1655 0.00 1701/1703 -2.22 1733/1737 -0.19 1712/1716 0.58

0.00 -2.24 -0.19 0.56
0.00 0.05 0.01 0.15
0.00 -2.24 -0.19 0.56

MRU Align StdDev gyro 0.15 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014Ryan Wartick

crm

9435380.tid

crm

crm

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Argento

Compute correctors in this order

064

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Marcus

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: NOAA Ship Fairweather Vessel: 2806

Date: 3/3/2014 Dn: 62

Personnel: SS Brooks, ENS Chensue, ENS Friel

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

Calibration area
Location:

2560

NOAA POS/MV Calibration Report

Newport OR

129.100.1.231

2014_062_2806.040 - 043
POSMV filename(s)

Location:

Approximate Position: Lat 44 37 36.76

Lon 124 2 46.66

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 287

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: 18 Sattelites in use: 10
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 2.483 (Use View> GAMS Solution)

Newport, OR

Secondary GPS

N



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 850

End time: 911

Heading accuracy achieved for calibration: 0.469

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name: posmv_config_2014_dn062_postGAMS

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2



COM3

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



2014 Fairweather HSRR: Launch 2806, DN 63 

3rd Order Ellipsoidally Referenced Dynamic Draft Measurement (ERDDM) 

 

 

 



 



Launch 2806 ERDDM (Delta Draft, M)

Historical Average 0 ‐0.034 ‐0.042 ‐0.038 ‐0.014 0.01 0.038 0.054 0.062 0.048 0.016 ‐0.048 ‐0.14333 ‐0.17 ‐0.24

Speed (m/s) 0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5 5.5 6 6.5 7 7.5 8 8.5 9 9.5 10 NOTES
Seattle,2010 0 ‐0.01 ‐0.01 ‐0.01 0.01 0.03 0.05 0.07 0.08 0.07 0.03 ‐0.05 ‐0.2 Seattle, WA
Seattle,2011 0 ‐0.06 ‐0.08 ‐0.07 ‐0.04 ‐0.02 0.01 0.01 0 ‐0.03 ‐0.08 ‐0.15 Seattle, WA

N/A,2012 none
Newport,2013 0 ‐0.06 ‐0.08 ‐0.08 ‐0.06 ‐0.02 0.03 0.08 0.12 0.13 0.11 0.03 ‐0.13 ‐0.37 Newport, OR Dn250

LA,2013 0 ‐0.02 ‐0.03 ‐0.02 ‐0.01 0 0.02 0.03 0.03 0.02 0 ‐0.03 LA/LB, CA Dn261
Newport, 2014 0 ‐0.02 ‐0.01 ‐0.01 0.03 0.06 0.08 0.08 0.08 0.05 0.02 ‐0.04 ‐0.1 ‐0.17 ‐0.24

0 1

0.15

‐0.05

0

0.05

0.1

0 1 2 3 4 5 6 7 8
Seattle,2010

Seattle,2011

Newport,2013

LA 2013

‐0.25

‐0.2

‐0.15

‐0.1

‐0.05
Seattle,2011

Newport,2013

LA,2013

Historical Average

Newport, 2014

‐0.3

‐0.25



Measuring Party:

Waterline measurements should be negative and cm!

Date: 3/7/2014
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0784 -0.0120 -0.0904

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.101

Individual 0.15415 0.06477
measurement 0.14115 0.05177
StDev for TPU xls 0.050 0.14415 0.05177
(of 6 #'s)

Measuring Party:

Date: 3/20/2014
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference -95

Avg (cm) Theoretical Actual Error

Avg (m) 0.0784 0.0050 -0.0734

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.093

(Add this value to VSSL_Offsets & Measurements_20XX.xls)

Individual 0.14415 0.05677
measurement 0.13215 0.04777
StDev for TPU xls 0.042 0.11415 0.06577 Averaged values utilized in Offsets and Measurements and TPU spreadsheet

(of 6 #'s)

Fill in Yellow squares only!

2806

Bradley, Argento, Ramsay

1.09615

Waterline Measurements

-96.600

2806
Port Benchmark to Waterline Stbd Benchmark to Waterline 101 gal

64 gal

-94.200 -95.300

-0.9617

-95.200

-0.9660

-98.200

0.146

-95.200

-95.200

2806

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.056

-95.500

0.00681 0.00751

0.13015 0.057

Waterline measurements should be negative and cm!

0.01510 0.00900

1.09615 1.01777

-96.100

-0.9610

-96.400

-96.60 -96.10

-97.000

-0.9497

1.01777

-96.600

-96.17

Bravo, Bradley, Berube, Nalley.

-94.97



  2807 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.019 0.804 n/a Scaler Distance 1.440 -0.786 -0.812 0.000 0.000
y 0.000 0.244 1.056 n/a -0.812 -0.786 0.000 0.000
z 0.000 0.481 3.628 -0.101 -3.147 -3.147 0.000 0.000

*IMU is Reference Point

Vessel Offsets for 2808 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2014 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.78576 RP to Waterline (m) IMU to x -0.78576 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.81181 z 0.101 Port Ant (m) y -0.81181 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.14689 (calculated) z 3.14689 z 0.00000 z 0.00000

MBES RP x 0.01867 IMU to x 0.01867 IMU (m) x, y, z 0.00000 Top of x -0.78576 Heave Pt (m)   x 0.00000
Rcvr - Phase (m)      y 0.24441 Phase Ctr y 0.24441 Port Ant (m)  y -0.81181 (by design) y 0.00000
Center z -0.48063 (calculated) z -0.48063 Top of x 0.65423 z 3.13559 z 0.00000

Stbd Ant (m)  y -0.81691
z 3.16283 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.06259
Bottom of Stbd Ant
(calculated) (m)  z 3.08983 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to x 0.01867 x 0.80443 x n/a x -0.78576 x 0.00000

Phase Ctr y 0.24441 y 1.05622 y n/a Scalar Distance 1.4403 y -0.81181 y 0.00000
z -0.48063 z -3.62752 z 0.101 z 3.14689 z 0.00000

Coord. Sys. x 0.01867 Coord. Sys. x 0.80443 Coord. Sys. x n/a Coord. Sys. x -0.81181 Coord. Sys. x 0.00000
CARIS y 0.24441 CARIS y 1.05622 CARIS y n/a Pos/Mv y -0.78576 Pos/Mv y 0.00000

z 0.48063 z 3.62752 z -0.101 z -3.14689 z 0.00000

IMU to 7125 (Receiver) Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave



x y z x y z x y z x y z x y z
0.019 0.244 0.481 0.804 1.056 3.628 N/A N/A -0.101 -0.786 -0.812 -3.147 0.000 0.000 0.000

RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave

Scalar Distance
1.440

Description of Offsets for Launch 2807

All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2807 was based from IMU Reference Point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

IMU to 7125 Port Ant to 7125

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

The values were calculated by 
subtracting the physical height  of 
the Port Antenna to the IMU x, y, z 
values from the respective values of 
the IMU to the 7125. The 
calculated values were then 
transposed from the NGS to the 
CARIS coordinate system.

The average vertical distance 
from Port Benchmark to waterline 
and the Starboard Benchmark to 
the waterline were measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were combined with
the Z value of the Benchmarks to 
the RP/IMU to get an average for 
the waterline to RP.  The 
Waterline Measurement value is 
in NGS coordinates initially and is 
converted to CARIS coordinates.

The location of the IMU and the 
location of the top of port antenna 
were surveyed by NGS.  The z-
value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base of 
the antenna to the phase center 
of the antenna. The calculation 
results were then transposed 
from the NGS to the CARIS 
coordinate system. 

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

1.440 m

3.147 m

3.628 m

0.481 m

0.019 m

7125 Phase Center

IMU Reference Pt.

Primary Antenna Reference Pt.

2807
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.80443 m
7125 to Port Ant.

0.0187 m

IMU Reference Pt.

1.440 m

0.244 m

7125 Phase Center

1.056 m

0.812 m
Primary Antenna Reference Pt.

2807
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.804 m
7125 to Port Ant.
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NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2807.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 27th of 
January, 2010.  The weather was foggy early then sunny  with  temperatures in the 40s to 
50s.  For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.001 m 
and a vertical accuracy of 0.000 m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU. The resulting coordinates are reported in 
appendix A. 
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 



NOAA SURVEY VESSEL 2807 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 

 



NOAA SURVEY VESSEL 2807 
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STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMC-  CENTERLINE CAB BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the cab, along the centerline of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 
 
 



Appendix A 
 

Coordinate Report Launch 2807 
 
Pt Name      North(Y) East(X) UP(Z)  ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13111    0.00714    -0.16724    IMUR  
Centerline Stern BM          -4.06155      -0.02156   0.64902     CLS   
Centerline Bow BM    3.44775    -0.02156   1.41160     BMB   
Portside GPS Ant. Ref. Point -0.81181   -0.78576   3.13559     GPSP  
Starboard GPS Ant. Ref. Point-0.81691   0.65423    3.16283     GPSS  
Multi-Beam Ref.Point    0.24441    0.01867      -0.48063    MB    
Keel BM      0.43114    0.01129    -0.61049    MBF   
Keel BM        -0.23560   0.00988    -0.53203    MBA   
Port Side BM     0.09979    -1.46918   1.03292     BMP   
Starboard Side BM     0.08626    1.42671    1.08830     BMS   
Centerline Cab BM       -0.21841   -0.05358   2.65245     BMC 
 
Units = meters 
   
 
 
           
   
      
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Appendix B  
 

Point to Point Inverse Launch 2807 
 

 
Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
18   37     0.002    -0.002     0.000     0.00024    MBF 
35   39     0.001    -0.001    -0.001     0.00027    MBA 
19   36     0.004     0.001     0.004     0.00043    MB 
29   27     0.006     0.001     0.006     0.00023    IMUR 
26   30     0.006     0.005     0.004     0.00012    IMU 
20   31     0.001    -0.001    -0.001     0.00038    CLS 
32   45     0.000     0.000     0.000     0.00005    BMP 
21    9     0.000     0.000     0.000     0.00057    BMS 
49   16     0.007     0.007     0.000     0.00076    BMB 
12   46     0.001    -0.001     0.000     0.00044    BMC 
11   47     0.003    -0.002     0.001     0.00094    GPSP 
10   48     0.002    -0.002     0.001     0.00068    GPSS 
 
Units = meters 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/12/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/12/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Yaquina Bay

Launch 2807 200kHz

Marcus,Baillio,Ferguson

Marcus,Baillio

FA2807

071

RESON 200kHz

1812023

sandy mud

ClearYaquina Bay

9m

071

Applanix POS/MV   S/N:3628   IMU S/N:XXX

Comments

1718 7.6
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1813 7.3
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

44/37/35.8N 124/02/26.88W2014_071_171853.HEX

POSMV Filename(s)
2014_071_2807.899-908

2014_071_181322.HEX 44/37/32.26N 124/02/32.34W



NAV TIME LATENCY
Line Number Heading Speed (kts Remarks

1 110 4.0
2 110 4.0
3 110 8.0
4 110 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts Remarks

1 290 5.0
2 110 5.0
3 290 5.0
4 110 5.0
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [same direction, same speed]
Line Number Heading Speed (kts Remarks

1 290 5.0
2 290 5.0
3 290 5.0
4 290 5.0
5
6
7
8

ROLL view across track same line [opposite direction same speed]

2014M_0711742
2014M_0711744

2014M_0711739

XTF Line Filename
2014M_0711737

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) [same 
direction, different speed]

2014M_0711753

2014M_0711724

SSP spikes

2014M_0711728
2014M_0711732
2014M_0711735

2014M_0711750

2014M_0711757

2014M_0711746
XTF Line Filename

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts Remarks

1 120 5.0
2 300 5.0
3 2014M_0711804 120 5.0
4 2014M_0711807 300 5.0
5
6
7
8

2014M_0711802
2014M_0711759
XTF Line Filename



Processing Log

3/12/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency Lines Used Latency (sec) Pitch Lines Used Pitch (deg) Roll Lines Used Roll (deg) Yaw Lines Used Yaw (deg)
2014M_0711724, 2010.00 2014M_0711737, 2-1.70 2014M_0711759,20.22 2014M_0711746,2014M_071175
1724/1732 0.00 1737/1744 -1.80 1804/1807 0.13 1746/1757 0.23
1724/1732 0.00 1737/1744 -1.80 1804/1807 0.15 1746/1757 0.17

0.00 -1.77 0.17 0.20
0.00 0.06 0.05 0.04

crm

M320RA2011CORP_Rev.zdf

crm

crm NIT

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Marcus
Wartick

071

Beduhn

TrueHeave applied

Averages
Standard Deviation

Marcus

Evaluators

Data converted --> HDCS_Data in CARIS

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

0.00 0.06 0.05 0.04
0.00 -1.77 0.17 0.20

MRU Align StdDev gyro 0.04 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.05 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014Ryan Wartick and Tami Bedhun

Final Values based on

Standard Deviation
FINAL VALUES

Resulting HVF File Name



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/10/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/17/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

076

ctd-13.3v

Applanix POS/MV   S/N:XXXX    IMU S/N:XXX

calm, cloudyYaquina Bay

Launch 2807 400kHz

Berube, Brooks, Marcus

076 Yaquina Bay

Comments

2034 10.29
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

ctd 13.3v

POSMV Filename(s)

2014_076_203442.HEX 44/37/30.37N 124/02/19.94W

2014_076_2807.941-.949



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 291 4.2
2 290 3.9
3 290 8.0
4 290 7.9

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 112 5.1
2 290 5.3

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 108 4.8
2 111 4.7
3 109 4.7
4 107 4.6

ROLL view across track same line [opposite direction same speed]

XTF Line Filename

2014M_0762105
2014M_0762109

2014M_0762050
2014M_0762053

2014M_0762101

2014M_0762112

2014M_0762047

XTF Line Filename

2014M_0762058

XTF Line Filename
2014M_0762056

2014M_0762042

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) [same 
direction, different speed]

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 300 5.6
2 126 5.7
3 2014M_0762122 300 5.5
4 2014M_0762125 121 5.5

XTF Line Filename

2014M_0762119
2014M_0762116



Processing Log

3/17/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency Lines Used Latency (sec) Pitch Lines Used Pitch (deg) Roll Lines Used Roll (deg) Yaw Lines Used Yaw (deg)
2014M_0762042,20140.00 2014M_0762056,2-1.23 2014M_0762116,0.06 2014M_0762101, -0.29
2047/2050 0.00 2056/2058 -1.63 2116/2119 0.11 2101/2105 -0.12
2047/2050 0.00 2056/2058 -1.46 2122/2125 0.10 2101/2105 -0.14

0.00 -1.44 0.09 -0.18
0.00 0.20 0.03 0.09

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS

Beduhn

Averages

076

Standard Deviation

Compute correctors in this order

Marcus

Evaluators

TrueHeave applied crm

9435380.tid

crm

crm NIT

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Marcus
Wartick

0.00 0.20 0.03 0.09
0.00 -1.44 0.09 -0.18

MRU Align StdDev gyro 0.09 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.11 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014

Resulting HVF File Name

Final Values based on

Standard Deviation
FINAL VALUES

Ryan Wartick, Tami Beduhn



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: S220 Vessel: 2807

Date: 3/3/2014 Dn: 62

Personnel: Marcus,Bradley,Ferguson

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics) V4
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:

Approximate Position: Lat 44 37 33N

Lon 124 2 50W

DGPS B St ti DGPS R i S i l#

37

NOAA POS/MV Calibration Report

Newport,OR

3628

F t St

129.100.1.231

2014_062_2807.828
POSMV filename(s)

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 287kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP (Use View> GAMS Solution)

Secondary GPS

N

Fort Stevens



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time:

End time:

Heading accuracy achieved for calibration: 0.469

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name: 2014_062.nvm

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2



COM3

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



2014 Fairweather HSRR: Launch 2807, DN 63 

3rd Order Ellipsoidally Referenced Dynamic Draft Measurement (ERDDM) 

 

 



 

 

 

 

 



Launch 2807 ERDDM (Delta Draft, M)

Historical Average 0 ‐4.3E‐19 0.01 0.0275 0.0425 0.0525 0.065 0.0625 0.055 0.0375 0.0025 ‐0.045 ‐0.10333 ‐0.12 ‐0.13 ‐0.16 ‐0.19 ‐0.22 ‐0.23

Speed (m/s) 0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5 5.5 6 6.5 7 7.5 8 8.5 9 9.5 10 NOTES
Seattle, 2010 0 ‐0.02 0 0.02 0.05 0.07 0.08 0.06 0.03 ‐0.01 ‐0.07 ‐0.12 ‐0.16 ‐0.17 ‐0.14 Seattle, WA
Seattle, 2011 0 0 0 0.01 0.02 0.03 0.05 0.07 0.09 0.09 0.06 ‐0.01 Seattle, WA

N/A, 2012 none
Newport 2013 0 0 03 0 05 0 08 0 09 0 1 0 11 0 1 0 09 0 07 0 04 0 01 ‐0 03 ‐0 07 ‐0 12 ‐0 16 ‐0 19 ‐0 22 ‐0 23 Newport ORNewport, 2013 0 0.03 0.05 0.08 0.09 0.1 0.11 0.1 0.09 0.07 0.04 0.01 ‐0.03 ‐0.07 ‐0.12 ‐0.16 ‐0.19 ‐0.22 ‐0.23 Newport, OR
Newport, 2014 0 ‐0.01 ‐0.01 0 0.01 0.01 0.02 0.02 0.01 0 ‐0.02 ‐0.06 ‐0.12 Newport, OR DN63

072B

0.1

0.15

‐0.05

0

0.05

0.1

0 1 2 3 4 5 6 7 8 9 10
Seattle, 2010

Seattle, 2011

Newport, 2013

20

‐0.2

‐0.15

‐0.1

‐0.05
,

Newport, 2013

Newport, 2014

Historical Average

‐0.25

‐0.2



Measuring Party:

Waterline measurements should be negative and cm!

Date: 3/11/2014
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) -0.0554 0.0090 0.0644

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.095

Individual 0.06292 0.12330
measurement 0.05992 0.13430
StDev for TPU xls 0.036 0.06692 0.12530
(of 6 #'s)

Measuring Party:

Date: 3/20/2014
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference -95

Avg (cm) Theoretical Actual Error

Avg (m) -0.0554 -0.0127 0.0427

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.106

(Add this value to VSSL_Offsets & Measurements_20XX.xls)

Individual 0.08492 0.12030
measurement 0.08092 0.12330
StDev for TPU xls 0.024 0.08792 0.13830 Averaged values utilized in Offsets and Measurements and TPU spreadsheet

(of 6 #'s)

-94.83 -96.10

-96.500

-0.9697

1.08830

-95.400

-96.07

Bravo, Bradley, Berube, Nalley

-96.97

0.084586667 0.127

Waterline measurements should be negative and cm!

0.00351 0.00964

1.03292 1.08830

-96.800

-0.9610

-95.200

2807

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.128

-97.300

0.00351 0.00586

-0.9483

-94.500

0.063

-95.000

-94.800

98.8 gal.

67 gal 

-97.000 -96.500

-0.9607

-96.600

Fill in Yellow squares only!

2807

Ramsay, Argento, Brinkley

1.03292

Waterline Measurements

-96.300

2807
Port Benchmark to Waterline Stbd Benchmark to Waterline



  2808 Offsets and Measurements - Summary

Measurement IMU 
aka to RP* SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.000 0.004 0.685 n/a Scaler Distance 1.453 -0.682 -0.837 0.000 0.000
y 0.000 0.250 1.086 n/a -0.837 -0.682 0.000 0.000
z 0.000 0.477 3.637 -0.110 -3.160 -3.160 0.000 0.000

*IMU is Reference Point -0.123

Vessel Offsets for 2808 7125 are derived from the NGS Survey, January 2010, Trimble Equipment Specs, and 2014 and 2010 Measured Values.

Calculations
Coord. Sys./
Source IMU (m) x 0.00000 IMU to x -0.68151 RP to Waterline (m) IMU to x -0.68151 IMU (m) x 0.00000 IMU (m) x 0.00000
NGS y 0.00000 Port Ant (m) y -0.83666 z 0.110 Port Ant (m) y -0.83666 y 0.00000 y 0.00000

z 0.00000 (calculated) z 3.15974 (calculated) z 3.15974 z 0.00000 z 0.00000

MBES RP x 0.00351 IMU to x 0.00351 IMU (m) x, y, z 0.00000 Top of x -0.68151 Heave Pt m)   x 0.00000
Rcvr - Phase (m)      y 0.24969 Phase Ctr y 0.24969 2010 RP to Waterline (m) Port Ant (m)  y -0.83666 (by design) y 0.00000
Center z -0.47677 (calculated) z -0.47677 z 0.123 Top of x 0.77098 z 3.14844 z 0.00000

Stbd Ant (m)  y -0.83402
z 3.13235 Base to top of Port Ant

(measured) (m)  z 0.073
Base to top of Stbd Ant
(measured) (m)  z 0.073 Bottom of Port Ant

(calculated) (m)  z 3.07544
Bottom of Stbd Ant
(calculated) (m)  z 3.05935 Base to Phase Cntr of Port Ant

(eqp spc) (m)  z 0.0843
Base to Phase Cntr of Stbd Ant
(eqp spc) (m)  z 0.0843

Coord. Sys.
NGS IMU to x 0.00351 x 0.68502 x n/a x -0.68151 x 0.00000

Phase Ctr y 0.24969 y 1.08635 y n/a Scalar Distance 1.4526 y -0.83666 y 0.00000
z -0.47677 z -3.63651 z 0.110 z 3.15974 z 0.00000

Coord. Sys. x 0.00351 Coord. Sys. x 0.68502 Coord. Sys. x n/a Coord. Sys. x -0.83666 Coord. Sys. x 0.00000
CARIS y 0.24969 CARIS y 1.08635 CARIS y n/a Pos/Mv y -0.68151 Pos/Mv y 0.00000

z 0.47677 z 3.63651 z -0.110 z -3.15974 z 0.00000

(2010 used for K5K)

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

(waterline 
worksheet)

IMU to 7125 Port Ant to 7125 RP to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave

IMU to 7125 (Receiver) Port Ant to 7125 RP* to Waterline  Port Ant to Stbd Ant IMU to Port Ant IMU to Heave



x y z x y z x y z x y z x y z
0.004 0.250 0.477 0.685 1.086 3.637 n/a n/a -0.110 -0.682 -0.837 -3.160 0.000 0.000 0.000

x y z
-0.564 0.790 0.777

IMU to K5K

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave

Scalar Distance
1.453

Description of Offsets for Launch 2808

All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 2808 was based from the IMU reference point as the 0,0,0 point.  Physical locations were measured with x,y,z offsets from this point.  These 
locations were used to calculate offsets of items with respect to each other, as described for each offset.

IMU to 7125 Port Ant to 7125 RP to Waterline

The physical positions of the IMU 
and the receiver phase center of 
the 7125 were measured during 
the NGS survey.  These physical 
measurements were taken while 
the launch was secured on the 
pier and thought to be as level as 
possible.  The measured values 
for the IMU and MB were taken 
directly for the report.  The 
difference is the offset from the 
IMU to the phase center of the 
7125 which was then transposed 
from the NGS to the CARIS 
coordinate system. 

The values were calculated by 
subtracting the physical height of 
the of the Port Antenna to the 
IMU x, y, z values from the 
respective values of the IMU to 
the 7125.  The calculated values 
were then transposed from the 
NGS to the CARIS coordinate 
system.

The average vertical distance 
from Port Benchmark to waterline 
and the Starboard Benchmark to 
the waterline were measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were combined 
with the Z value of the 
Benchmarks to the RP/IMU to get 
an average for the waterline to 
RP.  The Waterline Measurement 
value is in NGS coordinates 
initially and is converted to 
CARIS coordinates.

The location of the IMU and the 
location of the top of port antenna 
were surveyed by NGS.  The z-
value of the antenna was 
calculated by subtracting the 
height of the antenna and then 
adding the value from the base of 
the antenna to the phase center 
of the antenna. The calculation 
results were then transposed 
from the NGS to the CARIS 
coordinate system. 

The Heave Point is assumed to 
coincide with the IMU location.

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
surveyed by NGS.  The z-values
were adjusted to the phase 
center. Then the scalar distance 
between the phase centers was 
calculated. 

1.453m

3.160 m

3.637 m

0.477m

0.004 m

7125 Phase Center

IMU Reference Pt.

Primary Antenna Reference Pt.

2808
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.685 m
7125 to Port Ant.

0.004 m

IMU Reference Pt.

1.453 m

0.24969 m

7125 Phase Center

1.086 m

0.837 m
Primary Antenna Reference Pt.

2808
LOA:    8.64m
Beam:  3.48m
Draft:    1.12m

0.685 m
7125 to Port Ant.

The location of the IMU and the 
location of the forward keel  
benchmark were surveyed by 
NGS.  BM to K5K were measured 
by FAIRWEATHER personnel 
using a steel tape and bubble 
level.

0.790 m
-0.564 m

K5K Reference Pt.

0.777 m

-0.564 m 

K5K Reference Pt.
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NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, launch bench marks and the 
components of a POS MV navigation system aboard the NOAA survey vessel 2808.   
 
PROJECT DETAILS 
 
This survey was conducted in Seattle, WA at the NOAA Western Center on the 27th of 
January, 2010.  The weather was foggy then sunny with temperatures in the 40s to 50s.  
For this survey, the vessel was on blocks, supported by boat jacks.  The vessel was 
reported to have been leveled relative to the IMU. 
 
INSTRUMENTATION 
 
A  Leica TDA5005 precision total station was used to make all measurements. 

Technical Data: 
    
  Standard Deviation 
   Horizontal angle  0.5 seconds 
   Vertical angle   0.5 seconds 
   Distance measurement 1mm + 1ppm 
 
Leica precision prisms were used as sighting targets.  Prisms were configured to have a 
zero mm offset.   
 
 
PERSONNEL 
  
 Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
    kendall.fancher@noaa.gov 
 
 Dennis Lokken NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243  
    dennis.lokken@noaa.gov 
 
 
  
  
 
 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
DEFINITION OF  THE REFERENCE FRAME 
 
For this survey, data was collected in a 3-D right handed Cartesian coordinate system.  
The origin of this coordinate system is defined as the center of the IMU target.  The Y 
(Northing) axis is parallel to the centerline of the launch and is positive towards the bow 
of the launch.  The X (Easting) axis is perpendicular to the Y axis and is positive towards 
the starboard side of the launch.  The Z (Elevation) axis is perpendicular to the XY plane 
and is positive towards the top of the launch.  The coordinates of the points established 
this survey are reported in this coordinate system and are provided in Appendix A. 
 
SURVEY METHODOLOGY 
 
Four temporary control points, (1, 2, 3, and 4), were established around the vessel such 
that every point to be positioned on the launch could be observed from at least two 
separate locations.   
 
Coordinates of 100.000N, 100.000E, and 100.000U were assumed for temporary control 
point 1.  A distance and height difference were measured between control points 1 and 2.  
Temporary control point 2 was assumed to have an Easting of 100.000.  The measured 
distance between these two points was used to determine the Northing for temporary 
control point 2.  The height difference between the two points was used to determine the 
Up component for control point 2.  
 
Control point 1 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
Control point 2 was occupied and control point 1 was observed to initialize the 
instrument.  After initialization, control point 3 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 1. 
  
Control point 3 was occupied and control point 2 was observed to initialize the 
instrument.  After initialization, control point 4 and all visible points to be observed on 
the launch were observed in both direct and reverse. The stability of the instrument setup 
was checked at conclusion of the data set collection by checking back to temporary 
control point 2. 
 
 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Control point 4 was occupied and control point 3 was observed to initialize the 
instrument.  After initialization, all visible points to be observed on the launch were 
observed in both direct and reverse. Control point 1 was also observed in order to 
evaluate the accuracy of the traverse.  Inverse computations between the original and 
observed control point yielded a horizontal accuracy, or traverse closure of of 0.001m 
and a vertical accuracy of 0.000m. The stability of the instrument setup was checked at 
conclusion of the data set collection by checking back to temporary control point 2. 
 
Inverses were computed between the two positions determined for all points surveyed to 
evaluate their accuracy relative to the temporary control network. Inverse reports are 
included in appendix B. 
 
The reference frame was rotated using CENTERLINE STERN BM (CLS) as the point of 
rotation.  A zero degree azimuth was used during the rotation from CLS to 
CENTERLINE BOW BM (BMB).  The reference frame was then translated to relocate 
the origin of the reference frame to the IMU. The resulting coordinates are reported in 
appendix A. 
 
DISCUSSION 
 
The positions given for the POS GPS antennas (Zephyr Model II p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 
 

1) Determine the physical height of the GPS antenna.  This information is probably 
located on the antenna or with equipment documentation. 

2) Investigate to find the electronic 
phase center offset of the 
antenna.  This information is 
probably located on the antenna 
or with equipment 
documentation.  This value may 
also be available at the NGS 
website for antenna modeling. 

3) Subtract the total height of the 
antenna from the Z value for 
each antenna.  This will give 
you a Z value for the antenna 
ARP (antenna reference point) 

4) Then add to this value the 
electronic phase center offset 
value appropriate for the 
antenna model. 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
Two reference points (MBF and 
MBA) were positioned in order to 
facilitate future measurements to the 
Multi-Beam sensor by launch 
personnel.  These reference points are 
punch marks set along the center of 
the keel, at the locations described in 
the image at right. 
 
 
 
 
 
 
 
A point on the Multi-Beam transducer 
(MB) was measured directly this 
survey.  The measured point was at the 
center of the bottom of the transducer.  
No mark was left to indicate the 
measured point. 
 
 
 
 
 
 
 
 
The point positioned for the Inertial 
Motion Unit (IMU) this survey was 
the center of the target affixed to the 
top of the unit.  Additionally, a 
reference mark (IMUR) was 
established on the plate the IMU is 
attached to at a point where two 
scribed lines intersect, forward of the 
IMU. 
 
 
 
 
 

 



NOAA SURVEY VESSEL 2808 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

 
STATION LISTING 
 
BMB-  CENTERLINE BOW BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the bow of the launch. 

 
CLS-  CENTERLINE STERN BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
deck, along the centerline and near the stern of the launch. 

 
BMP-  PORT SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the port side of the launch. 

 
BMS-  STARBOARD SIDE BM 

The center of a cross mark inscribed into the top of a square metal flange, welded to the 
top of the deck, near the middle of and along the starboard side of the launch. 

 
MBF-  KEEL BM  

A punch mark set along the bottom center of the keel, fore of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
MBA-  KEEL BM 

A punch mark set along the bottom center of the keel, aft of the multi-beam transducer, 
0.030 m from a point where the keel makes a 90 degree angle upwards. 

 
IMU-  IMU TARGET 
  Center of a target affixed to the top of the IMU housing. 
 
IMUR-  IMU REFERENCE BM 

The intersection of two scribed lines atop a metal support plate for the IMU and forward 
of the IMU. 

 
GPSP-  PORT SIDE GPS ANTENNA REFERENCE POINT 
  The top center of the port side GPS antenna for the POS system. 
 
GPSS-  STARBOARD GPS ANTENNA REFERENCE POINT 

The top center of the starboard side GPS antenna for the POS system. 
 

MB-  MULTI-BEAM REFERENCE POINT 
  The physical bottom center of the Multi-Beam transducer. 
 
 
 
 
 
 
 
 
 
 
 



Appendix A 
 

Coordinate Report Launch 2808 
 
Pt Name      North(Y) East(X) UP(Z)  ID 
IMU Target      0.00000    0.00000    0.00000     IMU   
IMU Reference BM    0.13282    -0.00186   -0.16518    IMUR  
Centerline Stern BM          -4.07730   0.01391    0.61506     CLS   
Centerline Bow BM    3.44544    0.01391    1.44047     BMB   
Portside GPS Ant. Ref. Point -0.83666   -0.68151   3.14844     GPSP  
Starboard GPS Ant. Ref. Point-0.83402   0.77098    3.13235     GPSS  
Multi-Beam Ref.Point    0.24969    0.00351    -0.47677    MB    
Keel BM      0.44021    -0.00126   -0.60545    MBF   
Keel BM        -0.22600   0.00192    -0.53583    MBA   
Port Side BM     0.08204    -1.42963   1.07600     BMP   
Starboard Side BM     0.08324    1.46250    1.04444     BMS   
 
Units = meters 
   
 
       
    
      
   
  
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Appendix B  

 
Point to Point Inverse Launch 2808 

 
Pt. 1   Pt. 2     Dist.     Northing  Easting   Elevation  ID 
3    40   0.001   -0.001    0.000    0.00026    MBF 
5    42   0.003   -0.002   -0.001    0.00013    MBA 
4    41   0.002   -0.001   -0.002    0.00062    MB 
14   55   0.006   -0.005    0.004    0.00049    IMUR 
13   56   0.006   -0.004    0.004    0.00055    IMU 
43    6   0.001    0.000    0.001    0.00048    CLS 
33   44   0.000    0.000    0.000    0.00006    BMS 
8    22   0.001   -0.001    0.000    0.00039    BMP 
17   25   0.005    0.000    0.005    0.00011    BMB 
24   34   0.001    0.000    0.000    0.00049    GPSS 
23    7   0.000    0.000    0.000    0.00022    GPSP 
 
Units = meters 
 
 

 



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/11/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/11/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1615 9
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1727 9.4
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

2014_070_172753.HEX 44/37/26.24N 124/02/18.7W

Launch 2808 200kHz

Marcus, Ramsay, Davis

Marcus, Ramsay

FA 2808

070

Reson 200 kHz

2014_070_2808.394-.406

1812020

Newport,OR

clearNewport, OR070

POSMV Filename(s)

Applanix POS/MV   S/N:2564   IMU S/N:XXX

44/37/32.35N 124/02/15.8W



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 287 4.8
2 285 4.7
3 287 8.1
4 287 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 110 4.0
2 290 4.9
3 110 4.2
4 290 4.8
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 110 4.0
2 110 4.0
3 110 4.0
4 110 4.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 300 5.0
2 120 4.0
3 2014M_0701720 300 5.0
4 2014M_0701723 120 4.0
5
6
7
8

XTF Line Filename

multiple SSV spikes

2014M_0701653
XTF Line Filename

2014M_0701658

multiple SSV spikes (smiles)

2014M_0701707

fish-finder interference

multiple SSV spikes

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0701703

multiple SSV spikes (smiles)
multiple SSV spikes (smiles)

multiple SSV spikes
2014M_0701627

multiple SSV spikes (smiles)

2014M_0701631
2014M_0701634

multiple SSV spikes
multiple SSV spikes

multiple SSV spikes

multiple SSV spikes2014M_0701623

2014M_0701643
2014M_0701646

2014M_0701640

XTF Line Filename
2014M_0701637

multiple SSV spikes

2014M_0701716
2014M_0701713

XTF Line Filename



Processing Log

3/11/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1623/1627 0.00 1637/1640 -2.60 1720/1723 0.38 1653/1703 0.70
1623/1631 0.00 1643/1646 -2.66 1713/1723 0.44 1658/1707 0.60
1623/1627 0.00 1643/1646 -2.64 1720/1723 0.45 1653/1703 0.70

0.00 -2.63 0.42 0.67
0.00 0.03 0.04 0.06
0.00 -2.63 0.42 0.67

MRU Align StdDev gyro 0.06 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014

Data converted --> HDCS_Data in CARIS

070

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Marcus/Ramsay

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Ryan Wartick and Tami Beduhn

crm

M320RA2011CORP_Rev.zdf

crm

crm NID

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Argento
Wartick



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

3/14/2014
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Acquisition Log

3/14/2014
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

1907 8m
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

2002 10m
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

44/37/36.346N 124/02/29.529W

Launch 2808 400kHz

Chensue, Friel, Fergusen

Chensue, Friel, Fergusen

Hull Mount

073

400 kHz

2014_073_2808.414-434

Yaquina Bay

Clear, Calm, Slack TideNewport073

POSMV Filename(s)

Applanix POS/MV   S/N:XXXX    IMU S/N:XXX

2014_073_190743

2014_073_200213 44 37 29.3282N 124/02/17.5216W



NAV TIME LATENCY
Line Number Heading Speed (kts) Remarks

1 114 4.0
2 114 8.0
3 110 4.0
4 110 8.0
5
6
7
8

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 114 4.0
2 292 4.0
3 290 4.0
4 110 4.0
5
6
7
8

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 294 6.0
2 290 6.0
3 290 6.0
4 290 6.0
5
6
7
8

ROLL view across track, same line [opposite direction, same speed]
Line Number Heading Speed (kts) Remarks

1 117 6.3
2 292 6.1
3 115 6.3
4 2014M_0731956 290 6.1
5
6
7
8

2014M_0731924
2014M_0731926

2014M_0731919

XTF Line Filename
2014M_0731916

2014M_0731951
2014M_0731953

2014M_0731949

XTF Line Filename
2014M_0731916

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

2014M_0731941

2014M_0731922
2014M_0731926
2014M_0731931

2014M_0731933
XTF Line Filename

2014M_0731937

2014M_0731944

XTF Line Filename



Processing Log

3/14/2014
Date Dn Personnel

Zone file

Lines merged

Data cleaned to remove gross fliers

Latency 
Lines Used Latency (sec)

Pitch Lines 
Used Pitch (deg)

Roll Lines 
Used Roll (deg)

Yaw Lines 
Used Yaw (deg)

1916/1922 0.00 1916/1919 -1.71 1949/1951 0.40 1933/1937 0.30
1926/1931 0.00 1924/1926 -1.83 1953/1956 0.42 1941/1944
1916/1922 0.00 1919/1926 -1.60 1949/1951 0.40 1941/1944 0.42

0.00 -1.71 0.41 0.36
0.00 0.12 0.01 0.08
0.00 -1.71 0.41 0.36

MRU Align StdDev gyro 0.08 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.06 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 3/27/2014Ryan Wartick and Tami Beduhn

2014_073_2808.414-..434

9435380.tid

2014_073.svp

PATCH TEST RESULTS/CORRECTORS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Wartick
Marcus

Compute correctors in this order

073

Beduhn

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Berube

Evaluators

TrueHeave applied

Resulting HVF File Name

SVP applied

Tide applied

Do not enter/apply correctors until all evaluations are complete and analyzed.

Data converted --> HDCS_Data in CARIS



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: S220 Vessel: 2808

Date: 3/3/2014 Dn: 62

Personnel: Marcus,Bradley,Ferguson

PCS Serial # IMU Serial #

IP Address:

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics) V4
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:

Approximate Position: Lat 47 37 32.9N

Lon 124 2 50.1W

DGPS B St ti DGPS R i S i l#

324

NOAA POS/MV Calibration Report

Newport,OR

F t St

129.100.1.231

2014_062_2808.363-366
POSMV filename(s)

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 287kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP (Use View> GAMS Solution)

Secondary GPS

N

Fort Stevens



POS/MV Configuration
Settings

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time:

End time:

Heading accuracy achieved for calibration: 0.039

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name:

D:\HYPACK 2012\Projects\HSRR2012\Raw\Positioning



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2



COM3

SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver



2014 Fairweather HSRR: Launch 2808, DN 64 

4th Order Ellipsoidally Referenced Dynamic Draft Measurement (ERDDM) 

 

 



 

 

 

 

 



Launch 2808 ERDDM (Delta Draft, M)

Historical Average 0 ‐0.022 ‐0.02 ‐0.018 ‐0.008 0.006 0.02 0.026 0.028 0.014 ‐0.02 ‐0.01667 ‐0.06 ‐0.1 ‐0.14 ‐0.175 ‐0.205 ‐0.27 ‐0.3 ‐0.32 ‐0.32

Speed (m/s) 0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5 5.5 6 6.5 7 7.5 8 8.5 9 9.5 10 NOTES
Seattle,2010 Seattle, WA
Seattle,2011 0 ‐0.03 ‐0.03 ‐0.02 0 0.03 0.06 0.08 0.1 0.1 0.07 0.01 Seattle, WA

Newport,2012 0 ‐0.01 ‐0.01 0 0 0 0.01 0.01 0.01 ‐0.01 ‐0.06 ‐0.16 ‐0.33 Newport, OR
???,2012 0 ‐0.03 \ ‐0.05 ‐0.04 ‐0.03 ‐0.02 ‐0.02 ‐0.03 ‐0.05 ‐0.11 ‐0.18 ‐0.3 ??

Seattle,2013 0 ‐0.02 ‐0.02 ‐0.01 0 0.02 0.03 0.03 0.03 0.01 ‐0.01 ‐0.04 ‐0.07 ‐0.11 ‐0.14 ‐0.17 ‐0.18 Seattle, WA

Newport 2014 0 ‐0.02 ‐0.02 ‐0.01 0 0.01 0.02 0.03 0.03 0.02 0.01 ‐0.02 ‐0.05 ‐0.09 ‐0.14 ‐0.18 ‐0.23 ‐0.27 ‐0.3 ‐0.32 ‐0.32 Newport, OR

0.15

‐0.05

0

0.05

0.1

0.15

0 2 4 6 8 10 12
Seattle,2010

Seattle,2011

‐0.3

‐0.25

‐0.2

‐0.15

‐0.1

‐0.05
Seattle,2010

Seattle,2011

Newport,2012

???,2012

Seattle,2013

Historical Average

Newport 2014

‐0.4

‐0.35

‐0.3



Measuring Party:

Waterline measurements should be negative and cm!

Date: 3/7/2014
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0316 -0.0367 -0.0682

Stdev

BM Z-value (m)* RP to WL Average (m)
BM to WL (m) 0.114

Individual 0.14900 0.09044
measurement 0.15300 0.07344
StDev for TPU xls 0.038 0.14300 0.07644
(of 6 #'s)

Measuring Party:

Date: 3/20/2014
Fuel Level:

Measure 1 Draft Tube:

Measure 2

Measure 3 Port-to-Stbd Z-difference -95

Avg (cm) Theoretical Actual Error

Avg (m) 0.0316 0.0210 -0.0106

Stdev

BM Z-value (m) RP to WL Average (m)
BM to WL (m) 0.106

(Add this value to VSSL_Offsets & Measurements_20XX.xls)

Individual 0.11600 0.09544
measurement 0.11100 0.09844
StDev for TPU xls 0.008 0.10700 0.10844 Averaged values utilized in Offsets and Measurements and TPU spreadsheet

(of 6 #'s)

Fill in Yellow squares only!

2808

Ramsay, Bradley, Argento

1.07600

Waterline Measurements

-96.800

2808
Port Benchmark to Waterline Stbd Benchmark to Waterline 101 gal

97 gal

-92.700 -95.400

-0.9643

-93.300

-0.9647

-96.900

0.148

-93.600

-96.000

2808

Port Benchmark to Waterline Stbd Benchmark to Waterline

0.080

-92.300

0.00503 0.00907

0.111333333 0.101

Waterline measurements should be negative and cm!

0.00451 0.00681

1.07600 1.04444

-94.900

-0.9437

-96.500

-96.47 -94.37

-94.600

-0.9277

1.04444

-97.100

-96.43

Bravo, Bradley, Berube, Nalley.

-92.77



COM10

N
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A
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, 9600
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r ID
 IN

Crossover
Straight

Serial

Acquisition

DGPS Reciever

4800, N,8,1,none
Base 1 GPS, RTCM 1 or 9

WGS84

COM3

Key

3/16/2012

2805 - 2808 K5K & 7125 Wire Diagram

Ryan WartickRev 2.0

129.100.1.200
255.255.0.0

129.100.2.230
255.255.255.0

129.100.2.235
255.255.255.0

COM1

B
inary, 11

5,200, N
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z S
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rad 3

000T
S

S

COM2

COM4

POS MV 320

SBE 19plus CTD

9600, N,8,1, none

C
O

M
1

Reson 7125

C
O

M
2

(K
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n H
yperT
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inal

AIS
38400, n,8,1,n

COXN Fathometer

BNC Trigger
Output: Active, 

Pulse length 1 ms
B

N
C

 P
P

S

Klein 5000
192.168.0.81

192.168.0.82

COM1
9600, n, 8, 1, n (NULL)

4800, n, 8,1 none (NULL)
NMEA OUT GGA, VTG, 2Hz, 

Talker ID GP

COM4

129.100.1.231

129.100.1.215
255.255.0.0

Groups 3,7,20,102,111&113
50Hz

7125 I/O devices 
Position*: Positioning System Geog, POSMV Ethernet 102&104
HPR*: VRU, POSMV Ethernet 102
Heading*: Compass, POSMV Ethernet 102
Time: Com10, Trimble PPS&ZDA
Sound Velocity: COM3 Reson SVP70 AML 9600, N, 8, 1, n
*UDP | 129.100.1.231 | Port 5602

BNC Trigger
Input: Active, Rising Edge

XX.XX.XX.XX

COM5

C
O

M
3

(V
irtua

l)

INGGA, 9600, N,8,1,N (NULL) 1Hz 
(shoreline)

Not Currently 
integrated with 

Hypack

Base Station 
Radio Modem











Surface Difference = Surface1 ‐ Surface2

2805 2806 2807 2808 8160 7111 2805 2806 2807 2808 8160 7111
2805 0.043 0.147 0.241 #DIV/0! #DIV/0! 2805 0.031 0.02 0.027 #DIV/0! #DIV/0!
2806 0.104 0.198 #DIV/0! #DIV/0! 2806 0.035 0.045 #DIV/0! #DIV/0!
2807 0.094 #DIV/0! #DIV/0! 2807 0.03 #DIV/0! #DIV/0!
2808 #DIV/0! #DIV/0! 2808 #DIV/0! #DIV/0!

Surface Difference = Surface1 ‐ Surface2

2805 2806 2807 2808 2805 2806 2807 2808
2805 0.009 0.073 0.052 2805 0.049 0.06 0.028
2806 0.063 0.042 2806 0.072 0.047
2807 0.022 2807 0.063

Surface Difference = Surface1 ‐ Surface2

2805 2806 2807 2808 2805 2806 2807 2808
2805 0.081 2805 0.017111
2806 0.047 2806 0.037514
2807 0.007 2807 0.069364961
2808 ‐0.109 2808 0.029584789

Surface 1 
200KHz

Surface 1 
200KHz

Surface 2

Surface 2

Surface 2  400kHz

Average Surface 
Difference (m)

Surface 1

Average Surface 
Difference (m)

Resolution: 1 m
200 kHz to 400 kHz comparison 

Reference Surface Comparison

Surface 2

Surface 2

Surface 1

Surface 2  400 kHz

Surface 1

Standard Deviation

Standard Deviation

Standard Deviation

Frequency: 200 kHz
Resolution: 1 m

Frequency: 400 kHz
Resolution: 1 m

Average Surface 
Difference (m)

Surface 1



Speed (m/s) 0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5 5.5 6 6.5 7 7.5 8 8.5 9 9.5 10
2805 Newport,2014 0 0.07 0.13 0.17 0.19 0.19 0.18 0.15 0.11 0.05 ‐0.03 ‐0.11 ‐0.21 ‐0.33 ‐0.45
2806 Newport,2014 0 0.01 0.02 0.04 0.05 0.06 0.07 0.07 0.07 0.05 0.03 ‐0.01 ‐0.06 ‐0.13 ‐0.21
2807 Newport, 2014 0 0.01 0.02 0.03 0.05 0.05 0.05 0.04 0.01 ‐0.04 ‐0.11 ‐0.2 ‐0.33 ‐0.5 ‐0.7
2808 Newport,2014 0 0.02 0.04 0.05 0.06 0.07 0.07 0.07 0.06 0.05 0.04 0.03 0.01 ‐0.02 ‐0.05 ‐0.08 ‐0.12 ‐0.16 ‐0.21 ‐0.27 ‐0.32

‐0.8

‐0.7

‐0.6

‐0.5

‐0.4

‐0.3

‐0.2

‐0.1

0

0.1

0.2

0.3

0 2 4 6 8 10 12

2805

2806

2807

2808



MBES:

Measured by:

Location:

Chief of Party:          

Bravo, Berube, Bradley, Nalley

NOAA MOC-P

CDR David J. Zezula

Notes:  We were not able to see the lead 
line on the Reson, so the lead line 

measurement was the measurement from the 
side disk to the sediment surface, and the 
MBES measurement was estimated at 2 

meters of NADIR.  2805 does not currently 
have a TPU, so we did the lead line 

measurement, but not the MBES 
measurement.  

2807 - 3.76m 5.477m 1m

2808 - 4.93m 6.48m 1m

2805 - no TPU 7.081m 1m

2806 - 4.66m 6.155m 1m

20-Mar-14 HSST Douglas Bravo HAST Joy Nalley

MBES Measurement Leadline measurement Draft

Lead Line & MBES Comparison Report

Field unit: FAIRWEATHER

Lead Line / Sounding Pole Identification Number:  20-02-05
(Unique Identifier, with equipment type, date made, etc. )

7125

Lead Line Unit of Measure:  Meters (This should always be meters!)

Measured on: Recorded by: Checked by:



Appendix III 
 
 
Total Propagated Uncertainty (TPU) 
 
Fairweather TPU Values 
 
 



PROJECT
Tide Measurement (m)

(Use in CARIS)
Tide Zoning 95%

Provided by CO‐OPS)
Tide Zoning (m) ‐ 1 sigma 

(Use in CARIS)
SYSTEM

SV Measured (m/s)
(Use in CARIS)

SV Surface (m/s)
(Use in CARIS)

DEFAULT 0.01 0.2 0.10 7125 2 0.5
non‐TCARI 7111/8160 1 0.5

DEFAULT 0 0 0.00 7125 2 0.5
TCARI 7111/8160 1 0.5

OPR‐N305‐FA‐14 0.01 0.23 0.12 7125 2 0.5
Juan de Fuca

OPR‐P335‐FA‐14 0.01 Unknown at this time. TBD 7125 2 0.5
South Kodiak

Tides
Measured: 

Sound Speed
Measured:  Range (0.5m/s to 4 m/s) dependent on spatial and temporal variability

Use 1 m/s for casts every 15 min or less
Use 4 m/s for casts every 4 hours

Surface: Range (0.2 m/s to 2 m/s): dependent on surface sound speed gradient

TCARI automatically calculates the error associated with water level interpolation. This error is incorporated into the residual/harmonic solutions 
and included in the Total Propagated Error(TPE) for the survey.

Zoning (TCARI):

Tide zoning uncertainty values at the 95% confidence level for discrete zoning are provided by CO‐OPS in the tide requirements document on the project CD. All error value components 
entered in CARIS for TPE calculation are assumed to be 1 sigma; therefore, the value provided by CO‐OPS should be divided by 1.96.

TIDE and SOUND SPEED ‐ COMPUTE TPE VALUES

Range (0.01m ‐ 0.40m) dependent on distance from gauge, range of tide, rate of tide change, and meteorological factors. Value 
provided by CO‐OPS in the tide document in the project instructions package. 

Zoning (discrete): 
Range (0.01m ‐ 0.05m) dependent on gauge accuracy and duration of deployment



Appendix IV 
 
 
Additional Correspondence 
 
None 
 


		2015-01-20T14:47:22-0800
	Douglas Bravo


		2015-01-20T15:14:52-0800
	Matthew Forney


		2015-01-20T16:55:11-0800
	Ryan Wartick


		2015-01-20T19:59:27-0800
	David Zezula




